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01. BITTE VOR GEBRAUCH LESEN

Testaufnahmen

Vor den ersten Aufnahmen empfehlen wir unbedingt,
dass einige Testaufnahmen gemacht werden, um si-
cherzustellen, dass die Kamera einwandfrei funktio-
niert und dass diese auch korrekt bedient wird.

Wir miissen darauf hinweisen, dass Trotec®, ihre
Tochterunternehmen und Partner als auch die Auslie-
ferer flir keine Folgeschéaden haften, die durch einen
Defekt der IR-Kamera oder des Zubehors dazu fithren,
dass ein Bild nicht gespeichert wird oder dieses in
einem Format aufgezeichnet wird, das sich von einem
anderen Gerat nicht ablesen lasst.

Warnung vor Verletzung des Urheberrechts!
Sicherheitshinweise

Lesen Sie bitte unbedingt vor der Erstverwendung
diese Sicherheitshinweise und achten Sie bitte darauf,
dass sie auch verstanden werden. Achten Sie zudem
darauf, dass die IR-Kamera geméB ihrer Bestimmung
grundsatzlich ordnungsgeman benutzt wird.

Die Sicherheitshinweise auf den folgenden Seiten sind
dafiir vorgesehen, Sie richtig und sicher bzgl. des Ge-
brauchs der IR-Kamera und des Zubehors zu schulen,
um Sie und andere vor Verletzungen zu schiitzen oder
Schéden an der Ausriistung zu verhindern.

Warnungen

Lesen Sie bitte weiter, um mehr dber den richtigen
Gebrauch der IR-Kamera zu erfahren.

- Schutz vor Augenverletzungen

/\ Richten Sie den Laser niemals in die Augen
von Menschen oder Tieren. Dies kann zu er-
heblichen Verletzungen der Augen fiihren.

- Unerlaubtes Zerlegen

Das Zerlegen und/oder Veranderung irgendwelcher
Teile ist strengstens untersagt, es sei denn, es wird
ausdriicklich in diesem Handbuch darauf hingewie-
sen, dass solche Schritte zuldssig sind.

- Sofortige  Einstellung des Kamerabetriebs beim
Auftreten von Rauch oder giftigen Gasen

Eine Unterlassung kann zu Brand oder Stromschlag
flihren. Schalten Sie die Kamera sofort aus und
entfernen Sie den Akku oder ziehen Sie den Stecker.
Stellen Sie sicher, dass kein weiterer Rauch oder
andere Dampfe austreten.

- Sofortige  Einstellung des Kamerabetriebs nach
einem Sturz oder nach Beschéddigung des Kamera-
gehéuses.

Eine Unterlassung kann zu Brand oder Stromschlag
flihren. Schalten Sie die Kamera sofort aus und ent-
fernen Sie den Akku oder ziehen Sie den Stecker.

- Verwenden Sie bei samtlichen Reinigungs- oder
Wartungsarbeiten an der Kamera keine Mittel, die
Alkohol, Benzol, Verdiinnungsmittel oder andere
leicht entziindbare Substanzen enthalten.

Das Verwenden solcher Mittel kann zum Brand fiihren.

- Ziehen Sie den Stecker in regelméBigen Absténden
aus der Steckdose, um den Staub und Schmutz zu
entfernen, der sich am Stecker und an der Steck-
dose um die Stromzufuhr herum ansammelt.

Staub, der sich im Laufe der Zeit in staubigen, fetti-
gen und feuchten Umgebungen ansammelt, kann so-
viel Feuchtigkeit aufnehmen, dass es zu einem Kurz-
schluss mit anschlieBendem Brand kommen kann.

- Das Stromkabel nicht mit nassen Héanden bertihren

Das Beriihren des Stromkabels mit nassen Handen
kann zum Stromschlag fiihren. Ziehen Sie den Ste-
cker niemals an dem Stromkabel, sondern nur wie
vorgesehen mit dem Stecker aus der Steckdose.
Durch das Herausziehen des Steckers an dem
Stromkabel kann es zu Beschadigungen der Dréhte
bzw. der Ummantelung und zum anschlieBenden
Brand oder Stromschlag kommen.

- Das Stromkabel darf niemals gekiirzt, verdndert
oder durch das Abstellen schwerer Gegenstéinde
gequetscht, beschédigt werden.

Jede der oben aufgefiinrten Handlungen kann zu
einem Brand oder zum Stromschlag fiihren.
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- Benutzen Sie fiir die Stromversorgung nur das
empfohlene Zubehir.

Zubehor, das nicht ausd.r.i]cklich fiir diese IR-Kamera
zugelassen ist, kann zu Uberhitzungen, Deformierun-
gen, Brand, Stromschlag oder andere Gefahren fiihren.

- Bewahren Sie den Akku niemals in der Néhe einer
Heizquelle auf; setzen Sie wiederaufladbare
Batterien niemals Hitze aus und halten Sie sie
von offenen Flammen fern.

Akkus niemals in Wasser tauchen. Ein solches Tau-
chen kann die wiederaufladbaren Batterien bescha-
digen, so dass es zum Brand, Stromschlag, Explo-
sion, einer ernsthaften Gesundheitsgefahrdung oder
zum Austreten atzender Fliissigkeiten kommen kann.

- Versuchen Sie niemals den Akku oder Batterien zu
zerlegen, zu verédndern oder ihnen Hitze zuzufiihren.

Es bestenht die Gefahr der Gesundheitsgefédhrdung
durch Explosion. Wenn Sie mit dem Inhalt einer Bat-
terie in Kontakt kommen, miissen Sie die betreffende
Korperstelle, einschlieBlich Mund und Augen, aber
auch Kleidungsstiicken, sofort mit klarem Wasser
kraftig ausspulen und sofort einen Arzt aufsuchen.

- Vermeiden Sie schwere StoBe, die das Batteriege-
hduse beschéddigen kénnten, und achten Sie da-
rauf, dass die Batterien nicht herunterfallen.

Dies kann zum Auslaufen der Batterien fiihren.

- Achten Sie darauf, dass Sie Metallobjekte, wie zum
Beispiel Schiiisselanhénger, so aufbewahren, dass
es zu keiner Beriihrung der Batterieanschliisse und
einem eventuellen Kurzschluss kommit.

Dies konnte zu einer Uberhitzung, Verbrennungen
und anderen Verletzungen fiihren.

- Kleben Sie die Batterieanschliisse vor der Ent-
sorgung ab, damit diese nicht mit anderen Ob-
jekten unmittelbar in Beriihrung kommen.

Wenn Batterieanschliisse mit anderen metallischen
Gegenstandenin Miillcontainernin Bertihrung kommen,
kann dies zu einem Brand oder einer Explosion fiihren.
Entsorgen Sie Batterien stets in speziell dafiir vorgese-
hene Sammelbehélter, sofern diese vorhanden sind.

- Benutzen Sie nur die dafiir vorgesehenen Batterien
und Zubehdrteile.

Batterien, die nicht ausdriicklich fiir das Gerét be-
stimmt sind, konnen Explosionen oder ein Auslaufen
des Inhalts verursachen; dies kann zu Brénden, Ver-
letzungen und Umweltschaden fiihren.

- Trennen Sie nach dem Aufladen den Adapter
sowohl von der Kamera als auch von der Strom-
quelle, um die Brandgefahr und andere Risiken
auszuschlieBen.

Der Dauerbetrieb iiber einen langeren Zeitraum ohne
Unterbrechung kann dazu fiihren, dass es zu einer
Uberhitzung bzw. Deformierung des Geréts kommt,
welches wiederum einen Brand verursachen konnte.

- Benutzen Sie das Aufladegerét oder den Adapter
nicht, wenn diese Beschadigungen aufweisen oder
der Stecker nicht richtig eingesteckt ist.

Das Aufladegerat kann je nach Region unterschied-
lich sein.

- Geben Sie bitte besonders Acht beim Anschrauben
des Teleobjektives und des Objektivs fiir Nahauf-
nahmen (nicht im Lieferumfang enthalten).

Lose oder falsch verschraubte Objektive kénnen her-
abfallen und zerspringen; die Glasssplitter knnen
zu Verletzungen fiihren.

- Wenn die Kamera iiber einen ldngeren Zeitraum
ohne Unterbrechung benutzt wird, kann es zu Er-
wérmungen des Gehduses kommen.

Geben Sie bitte besonders Acht, wenn Sie die Kamera
liber einenlangeren Zeitraum benutzen,damanin solchen
Féllen ein Brennen an den Handen verspiiren kann.

Funktionsfehler vermeiden
Lesen Sie bitte weiter, um mehr dartiber zu erfahren,
wie Sie lhre IR-Kamera vor Defekten schiitzen konnen.

- Vermeiden Sie Beschéddigungen des Detektors der
IR-Kamera.

- Kondensation: Vermeiden Sie es, die Kamera gro3en
Temperaturschwankungen auszusetzen.

Wenn die IR-Kamera zu schnell von einer warmen
in eine kiihle Umgebung, oder umgekehrt, gebracht
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wird, kann dies dazu flihren, dass sich kleine Konden-
sattropfchen auf dem Gehduse oder im Inneren der
Kamera bilden.

Eine solche Kondensatbildung lasst sich vermeiden,
indem Sie die Kamera zuvor in den dafiir vorgese-
henen Plastikkoffer legen und der Kamera Zeit geben,
sichandieneueUmgebungstemperaturzugewéhnen,
bevor Sie sie wieder auspacken.

- Wenn sich Kondensat im Inneren der Kamera bildet.

Stellen Sie sofort den Betrieb der Kamera ein, sobald
Sie eine solche Kondensatbildung feststellen. Sollten
Sie die IR-Kamera dennoch weiterhin benutzen, kann
dies unwillkiirlich zu Beschadigungen fiihren. Ent-
fernen Sie den Akku und trennen Sie die Kamera
vom Netz und warten Sie, bis die Feuchtigkeit in der
Kamera verdunstet ist, bevor Sie sie wieder in
Betrieb nehmen.

- Lagerung (iber einen ldngeren Zeitraum

Entfernen Sie beiNichtbenutzung der Kameradiber einen
langeren Zeitraum den Akku oder die Batterien und be-
wahren Sie die Kamera an einem sicheren Ort auf. Die
Batterien entleeren sich sonst nach langerem Lagern.

02. KAMERAANSICHT

Vorderansicht
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03. ERSTE SCHRITTE

Den Akku aufladen

Vor der ersten Verwendung und anschlieBend immer,
wenn im Display das Symbol ,Akku schwach“ er-
scheint, das Akku-Pack wie hier beschrieben laden.

1. Die Kante des Akku-
Packs auf die Linie am
Akku-Ladegerat aus
richten,danndas Akku-
Pack in Pfeilrichtung
einschieben. Form und
Aussehen des Ladege-
rates konnen variieren,
beeinflussen jedoch
nicht den Akku bzw.
dessen Leistung.

2. Das Netzkabel am Akku-Ladegeréat anschlieBen und
mit dem anderen Ende in eine Steckdose stecken.

e Die Ladeanzeige leuchtet, solange geladen wird, und
erlischt, wenn der Ladevorgang abgeschlossen ist.

e Nach dem Laden das Akku-Ladegerat abstecken
und das Akku-Pack entnehmen.

e |nder Kamera werden Lithium-lonen-Akkus verwendet.
Diese miissen vor demAufladen nicht vollstindig ent-
laden werden, sondern konnen jederzeit aufgeladen
werden. Da die maximale Zahl der Ladezyklen (die
Lebensdauer der Akkus) ungefahr 300 betragt, em-
pfiehlt es sich jedoch, das Akku-Pack nur aufzu-
laden, wenn es vollstindig entladen ist, um so seine
Lebensdauer zu verlangern.

¢ Die Ladezeiten hdngen von der Umgebungsfeuchtig-
keit und dem Ladezustand des Akku-Packs ab.

/\ VorsichtsmaBnahmen beim Umgang
mit dem Akku-Pack

¢ Die Klemmen des Akku-Packs und die Kontaktstellen
in der Kamera stets sauber halten. Verschmutzte
Klemmen kénnen zu mangelhaftem Kontakt zwischen
dem Akku-Pack und der IR-Kamera fiihren. Die Klem
men vor dem Laden oder Einsetzen des Akku-Packs
mit einem Tuch oder trockenen Lappen polieren.

e Das Akku-Ladegerat beim Laden nicht verdecken
(z. B. mit einem Tischtuch, Kissen oder Laken). Im
Ladegerat konnte sich Wéarme stauen und ein
Brand entstehen.

e Keine anderen Akkus als das im Lieferumfang ent-
haltene Akku-Pack laden. Dies konnte eine Storung
verursachen.

o Selbst bei ausgeschalteter Kamera entladt sich das
Akku-Pack geringfiigig, wenn es in der Kamera ge-
lassen wird. Dadurch verkiirzt sich seine Lebens-
dauer. Nehmen Sie es deshalb heraus, wenn die
Kamera nicht in Gebrauch ist.

e Passen Sie auf, dass die Klemmen nicht mit Metall-
gegenstanden wie z. B. Schliisselhaltern in Kontakt
kommen, da dadurch das Akku-Pack Schaden
nehmen kann. Um das Akku-Pack zu transportieren
oder — wenn es nicht gebraucht wird — zu lagern,
stecken Sie es immer in die mitgelieferte Tasche
und bewahren es an einem kiihlen, trockenen Ort auf.

¢ (eladene Akku-Packs entladen sich naturgemas,
auch wenn sie nicht benutzt werden. Es empfiehlt
sich daher, die Akkus am Tag ihres Einsatzes oder
einen Tag davor zu laden, damit sie auch tatsach-
lich voll sind.

e Da sich die Lebensdauer eines voll geladenen
Akku-Packs bei langerer Lagerung (etwa 1 Jahr)
verkiirzt oder seine Leistung sinken kann, emp-
fiehlt es sich, das Akku-Pack in der IR-Kamera zu
benutzen, bis das Symbol ,Akku schwach“ ange-
zeigt wird, und es dann bei normaler Temperatur
(30 °C) oder weniger zu lagern. Wird das Akku-
Pack lange nicht verwendet, sollte es mindestens
einmal jahrlich voll aufgeladen und anschlieBend
in der Kamera vollstandig entladen werden, bevor
es wieder gelagert wird.

e Solange die Kamera eingeschaltet ist, verbraucht
sie die Akku-Ladung, auch wenn gar keine Funktion
benutzt wird. Achten Sie deshalb insbesondere da-
rauf, ob die IR-Kamera nicht zur Schonung der
Akku-Ladung ausgeschaltet werden kann.

e Obwohl das Akku-Pack auf maximal 0 bis 40 °C aus-
gelegt ist, liegt die optimale Betriebstemperatur bei
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10 bis 30 °C. Bei niedrigen Temperaturen wie z. B.
bei Arbeiten in einem Kiihlhaus nimmt die Leistung
voriibergehend ab, so dass sich die nutzbare Zeit
bis zum néchsten Aufladen verkirzt.

e Hat sich die nutzbare Zeit eines Akku-Packs selbst
bei voll geladenem Zustand wesentlich verringert,
ist das Akku-Pack auszuwechseln.

Einsetzen des Akkus und der CF-Karte

Setzen Sie das geladene Akku-Pack NP-F570 (im Lie-
ferumfang enthalten) wie folgt in die Kamera ein:

1. Priifen, dass die Stromzufuhr ausgeschaltet ist, dann
die Verriegelung des Akkufachdeckels in Pfeilrichtung
driicken.

2. Das Akku-Pack einsetzen.
e Die Seite mit den Klemmen muss nach oben zeigen.
e Das Akku-Pack vollstindig einschieben, bis die Akku-

Verriegelung einrastet. Um das Akku-Pack herauszu-
nehmen, auf die Akku-Verriegelung driicken.

3. Das Akkufach schlieBen.

/\ Wenn die Kamera nicht in Gebrauch ist, sollten
Sie das Akku-Pack herausnehmen.

Sie miissen den internen Speicher im Format FAT
bzw. FAT16 formatieren. Andernfalls kann es
passieren, dass die IR-Kamera den internen
Speicher nicht erkennt.

Symbole zum Akku-Ladezustand
Mit folgenden Symbolen wird im LCD-Display der La-
dezustand der Akkus angezeigt.

i () 0 Akku ausreichend geladen
1 Akkuschwach

| Akku auswechseln oder aufladen

Das Gerét ein- und ausschalten
Solange die Kamera eingeschaltet ist, leuchtet die Be-
triebsanzeige.

1. Zum Ein- bzw. Auschalten halten
Sie den Ein-/Aus-Schalter (A) ca. 3
Sekunden gedriickt.

2. Nach einer Weile erscheint auf dem
Bildschirm die Startanzeige.

Die Verwendung des Headsets

Um Sprechkommentare aufzunehmen und wiederzuge-
ben, kann das Headset (im Lieferumfang enthalten) an
die Kamera angeschlossen werden. Sie konnen Bilder
mit Sprechkommentar speichern.

1. Die IR-Kamera ausschalten.

2. Das Headset-Kabel in die Headset- | g /
Buchse (B) am Kameragehéduse /
stecken.

3. Die IR-Kamera einschalten.
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Datum und Uhrzeit einstellen

Wenn Sie die IR-Kamera zum ersten Mal einschalten,
miissen Sie das Datum und die Uhrzeit einstellen.

1. Stellen Sie sicher, dass die Kamera im (Null) Modus ist.

2. Durch Driicken der
MENU-/ EINGABE-Taste
und anschlieBend des
Pfeils nach « LINKS /
RECHTS » auf dem
Tastenfeld das Setup-
menii [Setup] 6ffnen.

3. Durch Driicken des Pfeils nach OBEN 4 oder UNTEN
v auf dem Tastenfeld die Option [Date & Time] ein-
stellen, dann die MENU-/EINGABE-Taste driicken.

4. Datum und Uhrzeit einstellen

e Das Feld, das Sie an-
dern mochten, errei-
chen Sie mit dem
Pfeil nach OBEN A
oder UNTEN V¥ auf
dem Tastenfeld.

e Zum Einstellen der Werte den Pfeil nach « LINKS /
RECHTS » auf dem Tastenfeld driicken.

5. Sind alle Einstellungen ausgefiihrt, das Meniifenster
durch Driicken der Menti-/Enter-Taste schlieBen oder
durch Driicken von Taste C ohne Speichern verlassen.

Lokale Einstellungen

Dieser Meniipunkt lasst Sie weitere Einstellungen im
eingebauten Menii vornehmen.

1. Priifen, dass sich die Kamera im Null-Modus befindet.

2. Durch Driicken der
MENU-/EINGABE-Taste
und anschlieBend des
Pfeils nach « LINKS /
RECHTS » auf dem
Tastenfeld das Setup-
meni [Setup] 6ffnen.

3. Durch Driicken des Pfeils nach OBEN A oder UNTEN ¥
auf dem Tastenfeld die Option [Other] einstellen,
dann die MENU-/EINGABE-Taste driicken.

4. Andere Einstellungen.

e Das Feld, das Sie
andernmochten, er-
reichen Sie mit dem
Pfeil nach OBEN A
oder UNTEN V¥ auf
dem Tastenfeld.

e Zum Einstellen der Werte den Pfeil nach « LINKS
oder RECHTS » auf dem Tastenfeld driicken.

5. Sind alle Einstellungen ausgefiihrt, das Meniifenster
durch Driicken der Menti-/Enter-Taste schlieBen oder
durch Driicken von Taste C ohne Speichern verlassen.

Informationen iiber lokale Einstellungen

- Datumsformat
Hier stellen Sie das Zeitformat ein.
DD: steht fiir Tag
MM: steht fiir Monat
YY: steht fiir Jahr

- Data Hintergrund
Hier stellen Sie ein, vor welchem Hintergrund die
Temperatur angezeigt werden soll.
Transparent: Die Temperaturdaten werden ohne
Hintergrundfarbe angezeigt.
Die Temperaturdaten werden mit
weiBem Hintergrund angezeigt.

- Temp. Einheit
Hier stellen Sie ein, in welcher Einheit die Temperatur
angezeigt werden soll, °C oder °F.

- Entfernungseinheit
Hier stellen Sie ein, in welcher Einheit die Entfernung
angezeigt werden soll, Meter oder Feet (FuB).

- Sprache
Hier stellen Sie ein, welche Sprache in den Meniis und
Meldungen verwendet werden soll.

- USB Mode
Hier stellen Sie den USB-Modus der Kamera ein.
FlashDisk oder Real-Time (Echtzeit)

- lluminator
Hier aktivieren bzw. deaktivieren Sie die Leuchte flir
die integrierte Digitalkamera.

Solid:

A-7

Bedienungsanleitung — Infrarotkamera




/\ Um Bilder wéhrend der Thermographie zu spei-
chern muss ,,Real Time* eingestellt sein.

Sollen die Bilder spéter per PC ausgelesen werden,
muss vor dem Anschluss an den PC auf ,,Flash
Disk* umgestellt werden! Ansonsten generiert
Windows eine Fehlermeldung, da die Kamera nicht
als Wechseldatentirager erkannt wird! Sollten Sie
das Umstellen auf ,,Flash Disk“ vergessen haben,
trennen Sie zunéchst das USB-Kabel von der Ka-
mera, stellen Sie dann von ,,Real-Time“ auf
»Flash-Disk“ um und schlieBen Sie danach
wieder das USB-Kabel an die Kamera an.

04. GRUNDFUNKTIONEN

Benutzung des LCD-Monitors

Wenn Sie den LCD-Monitor benutzen mochten, umWarme-
bilder aufzunehmen oder wiederzugeben oder um
Mentieinstellungen vorzunehmen, gehen Sie wie folgt vor.

1. Offnen Sie das Display in Pfeilrichtung.
2. Zielen Sie mit der Kamera auf das Zielobjekt.

e Achten Sie darauf,
dass das Zielob-
jekt in der Mitte
desLCD-Displays
erscheint, um bes-
sere Messergeb-
nisse zu erzielen.

 Das Display schal-
tet sich automa-
tisch aus, wenn es wieder zugeklappt wird.

Verwendung des Bildsuchers

Den Bildsucher ver-
wenden Sie, wenn die
Umgebung zu hell ist
(z.B. bei Aufnahmen im
Freien) und die Bilder
im LCD-Monitor nicht
Klar zu erkennen sind.
(Der Bildsucher zeigt
das gleiche Bild und
die gleichen Informationen wie der LCD-Monitor an.).

Dioptrienausgleich

Sie konnen den Bildsucher mit dem Dioptrienausgleich
an lhre Sehstarke anpassen, so dass Sie die Display-
Informationen scharf und deutlich sehen.

Kontrolle der Informationen im Monitor/Bildsucher

Sowohl der LCD-Monitor als auch der Bildsucher haben

ein Gesichtsfeld von 100 % der tatsdchlichen Aufnahme.

Nachstehend ist eine Informationsansicht dargestellt.
Messwert

. i—Farbskala

pr37.9 |l
24.7[ze.a.—untere Grenze
Prof C:Cancel Il [ 82 8411 20:88 23C der Farbska|a

T Datum |—|_'

Live Uhrzeit
Standbild

Akkuladezustand

Umgebungstemperatur
Uber die Statusanzeige

Die Statusanzeige zeigt den Status der Kamera und
die zur Verfiilgung stehenden Schnelltasten an:

Status der in diesem Status
Kamera verfiigharer Hotkey

‘ll’no!‘“c:Cancell g' }

Menu Steht fiir den Mentimodus.
Null Steht fiir den Nichtmeniimodus; es ist kein
Analysetool gewahlt.
Zeigt an, dass das aktuelle Analysetool
Sp1 ... Sp9 Spot1, Spot2 ... oder Spot9 ist.
Zeigt an, dass das aktuelle Analysetool die
Status Cap automatische Verfolgung eines
der Kamera Punktes (Max- oder Min-Temp.) ist.
Al ... ATS Zeigt an, dass das aktuelle Analysetool
Areal,Area? ... oder Area5 ist.
Prof Zeigt an, dass das aktuelle Analysetool die
Profilanalyse ist.
Isot Zeigt an, dass das aktuelle Analysetool die
Isothermen-Analyse ist.
Hotkey Zeigt an, dass Sie das aktuelle Analysetool
indiesem |C: Cancel |durch Driicken der Taste C (Cancel,
Status Abbrechen) riickgangig machen kénnen.
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Meniiauswahl und Einstellungen

Die Einstellungen kénnen Sie mit der MENU-/EINGABE-
Taste wéhlen.

1. MENU-/EINGABE- —
Taste driicken.

2. Pfeil nach « LINKS
RECHTS » auf
dem Tastenfeld
driicken.

3. Pfeil nach OBEN A
oder UNTEN V¥ auf

dem Tastenfeld
driicken.

4. MENU-/EINGABE-Taste driicken.

Beispiel
1. Driicken Sie zunéchst die Eingabetaste.

®

2. AIs néchstes wahlen Sie
mit dem Tastenfeld @ @
eine Menii-Funktion aus. \ \ P

Datei-Menii

Bild-Menii

Setup-Menii

4. Driicken Sie erneut die
Eingabetaste, um
Ihre Wahl zu bestétigen.

®

/A Die abgebildeten Meniipunkte werden auf-
grund der jeweiligen Einstellungen von Fall
zu Fall unterschiedlich sein!

Riicksetzen der Einstellungen auf die Standardwerte

Die Menti- und Tasteneinstellungen konnen Sie bei Bedarf
auf die Standardwerte zurlicksetzen.

1. Die IR-Kamera
ausschalten (A).

2. Den C-Schalter (B)
wahrend des
erneuten Einschal-
tens der Kamera
gedriickt halten, bis
die Systeminforma-
tionen im LCD-Bild-
schirm angezeigt werden.

05. AUFNAHME

Manuelle Fokussierung

Zielen Sie mit der IR-
Kamera auf das Objekt
und stellen Sie das Bild
durch Drehen des Fo-
kusrings scharf.
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Bild zoomen

Das Bild kann bis zu

einem Faktor von unge-

fahr 8 (in 0,1-Schritten)

digital gezoomt werden.

1. Priifen, dass sich die e
IR-Kamera im Null- [~ 1
Modus befindet.

Faktor
2. Zum Herauszoomen den Pfeil nach RECHTS » ,zum
Hineinzoomen den Pfeil nach « LINKS auf dem Tas-
tenfeld driicken. Der Faktor zeigtdie Einstellung nach
dem Zoomen an.

/\ Je stirker das Bild digital gezoomt wird,
desto grober wird die Bildqualitat.

Quad-Anzeige

Es kénnen bis zu 4 Bilder
gleichzeitig angezeigt und
erfasst werden. In der
Quad-Anzeige kdnnen Sie
die 4 gleichzeitig ange-
zeigten Bilder miteinander
vergleichen.

1. Priifen, dass sich die IR-Kamera im Null-Modus
befindet.

2. Pfeil nach « LINKS auf dem Tastenfeld driicken.
-Es erscheinen gleichzeitig vier Bilder.

3. Um ein Bild auszuwéhlen und zu aktivieren, den
Pfeil nach « LINKS / RECHTS » auf dem Tastenfeld
driicken.

- Es wird nur das gewéhlte Bild aktiviert. Das ge-
wihlte Bild kdnnen Sie einfrieren/aktivieren.

- Die nicht markierten Bilder sind eingefroren.

4. Um den Quad-Anzeigemodus zu beenden, Bild 1
wéhlen und auf dem Tastenfeld den Pfeil nach
RECHTS » driicken.

Waérme- und Sichtbildanzeige

Diese IR-Kamera zeichnet iiber eine integrierte Digital-
kamera auch Sichtbilder auf. Ein Sichthild kdnnen Sie als
Zusatzinformation zu einem Warmebild aufnehmen.

1. MENU-/EINGABE-Taste driicken.

2. Durch Driicken des
Pfeils nach < LINKS /
RECHTS » auf dem
Tastenfeld das Bild-
menii wahlen.

3. Durch Driicken des
Pfeils nach OBEN A
oder UNTEN ¥ aufdem
Tastenfeld die Option
[IR/CCD] wéhlen, dann
die MENU-/EINGABE-
Taste driicken.

- Im LCD-Monitor (oder
Bildsucher) erscheint
ein Untermenti.

4. Durch das Driicken des
Pfeils nach OBEN A
oder UNTEN ¥ auf dem
Tastenfeld den gewiin-
schten Anzeigemodus
wahlen, driicken Sie
dann die MENU-/EIN-
GABE Taste.

Nur Bild

In diesem Modus werden alle Informationen einschlieB-
lich der Analysetools und Temperaturdaten angezeigt.

1. MENU-/EINGABE-Taste driicken.

2. Durch Drlicken des
Pfeils nach < LINKS /
RECHTS » auf dem
Tastenfeld das Bild-
menii [Bild] wéhlen.
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3. Durch Driicken des
Pfeils nach OBEN A
oder UNTEN V¥ auf
dem Tastenfeld die
Option [Nur Bild] wah-
len, anschlieBend die
MENU-/EINGABE-
Taste driicken. Es
werden alle Informationen angezeigt.

4. Zum Beenden des Modus ,Nur Bild“ konnen Sie
eine beliebige Taste driicken.

e
Datei fmalyse GFEM Einstellung

Verwendung der Leuchte

Mit der integrierten Leuchte konnen dunklere Bereiche
ausgeleuchtet werden. Das gibt Ihnen die Maglichkeit,
immer klare und hochwertige Sichtbilder zur Dokumen-
tation Ihrer Inspektionen anzufertigen.

1. MENU-/EINGABE-Taste driicken.

2. Durch Driicken des
Pfeils nach « LINKS /
RECHTS » auf dem
Tastenfeld das Setup-
menii  [Einstellungen]
wahlen.

3. Durch Driicken des
Pfeils nach OBEN A

Datei Analyse  Bild

[Einstellung]

oder UNTEN Vv auf Eiistai=Sonstige
dem Tastenfeld die bt T
. . .- Ter Einheit: i
Option [Sonstige] wéh- Euler sk inkelt HEES
X . Sprache:
len, dann die MENU-/ e T
EINGABE-Taste drticken.

4. Durch Driicken des
Pfeils nach OBEN A

oder UNTEN v dem

auf
Tastenfeld die Option [llluminator] wahlen.

5. Die Leuchte wird durch Driicken des Pfeils nach
< LINKS / RECHTS » auf dem Tastenfeld aktiviert
bzw. deaktiviert.

/\ Je stirker das Bild digital gezoomt wird,
desto grober wird die Bildqualitat.

Laserpointer

Den Laserpointer (A) kbnnen Sie
durch Driicken des Auslosers
aktivieren, zum Deaktivieren
den Laser-Ausldser wieder los-
lassen.

Bild automatisch abgleichen

Wenn Sie im Menii die Option Auto adjust wéhlen oder
die Taste A driicken, gleicht die IR-Kamera die Hellig-
keit und den Kontrast automatisch ab.

1. Driicken Sie die Menii-/
Eingabe-Taste.

2. Durch Driicken des
Pfeils nach « LINKS /
RECHTS » aufdem
Tastenfeld das Bild-
menii wahlen.

Hanuell ein b [ =]

3. Durch Driicken des

Pfeils nach a OBEN
bzw. UNTEN Vv auf ey
dem Tastenfeld die

Option [Auto adjust]
wahlen, dann die ME-
NU-/EINGABE-Taste
driicken.

>

Bild manuell abgleichen

Mit dem integrierten Meniisystem oder durch Drii-
cken der Pfeile auf dem Tastenfeld kdnnen Sie die
Bildparameter ,Level“ und ,Span“ auch manuell ab-
gleichen. Der Parameter ,,Span“ wird mit den Pfeilen
nach OBEN A und UNTEN V¥, der Parameter ,Level“
mit den Pfeilen nach « LINKS/RECHTS » geéndert.

1. Driicken Sie die Mentl-/
Eingabe-Taste.

2. Durch Driicken des
Pfeils nach <« LINKS/
RECHTS » auf dem
Tastenfeld das Bild-
menii [Image] wéahlen.
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3. Durch Driicken des
Pfeils nach OBEN 4 o.
UNTEN ¥ aufdemTas-
tenfeld die Option
[Manuell ein.] wahlen,
danndie MENU-/EIN-
GABE-Taste driicken.

4. ,Level“ und ,Span“ abgleichen:

- Das Feld, das Sie
andernmochten, er-
reichen Sie mitdem |;
Pfeil nach « LINKS/
RECHTS » auf dem

Spanne (,Span”)

Level

Tastenfeld.

- Zum Einstellen der Werte den Pfeil nach OBEN A
oder UNTEN V¥ auf dem Tastenfeld driicken.

5. AnschlieBend die vorgenommenen Anderungen
durch Driicken der MENU-/EINGABE-Taste spei-
chern oder das Menii durch Driicken von Taste C
ohne Speichern schlieBen.

Messbereich

Um den Infrarotdetektor der Kamera vor zu intensiver
IR-Strahlung zu schiitzen, ist fiir die Temperaturberei-
che > 250 °C die mitgelieferte Filterlinse anzubringen.

Durch den zusatzlich anzupassenden Messbereich in
der Kamera kann sich die Bildhelligkeit veringern.

1. Driicken Sie die Menii-/Eingabe-Taste.

2. Durch Driicken des
Pfeils nach « LINKS /
RECHTS » auf dem
Tastenfeld das Bild-
menti [Bild] wahlen.

3. Durch  Driicken des
Pfeils nach OBEN A
oder UNTEN ¥ aufdem
Tastenfeld die Option
[Manuell ein.] wahlen,
anschlieBend die ME-
NU-/EINGABE-Taste
driicken.

4. Messbereich einstellen:
-Durch Driicken des
Pfeils nach < LINKS / |*S5ic *i5.cc B e
RECHTS » auf dem
Tastenfeld den Para-
meter ,,Range” (Mess-
bereich) wahlen.
- Mit dem Pfeil nach OBEN A oder UNTEN ¥ auf dem Tas-
tenfeld den Messbereich einstellen.
-Diese Option steht nicht zur Verfligung, wenn das
Bild eingefroren ist.
5. AnschlieBend das Mentifenster durch Driicken der
Menii-/Eingabe-Taste schlieBen.

Bereich
(,Range*)

Bild einfrieren/aktivieren

Das Thermobild lasst sich durch Driicken der S-Taste

auf dem Selektor aktivieren oder einfrieren.

1. MENU-/EINGABE-Taste driicken.

2. Durch Driicken des
Pfeils nach < LINKS /
RECHTS » auf dem
Tastenfeld das Bild-
menii [Bild] wahlen.

3. Durch Driicken der
Menii-/Eingabe-Taste
auf dem Tastenfeld konnen Sie zwischen den Optionen
Livebild [Live] und Standbild [Standbild] wechseln.

Bildeinstellungen

1. Driicken Sie die Menii-/
Eingabe-Taste.

2. Durch Driicken des
Pfeils nach < LINKS /
RECHTS » aufdemTas-
tenfeld das Setupmenii
[Einstellung] wahlen.

3. Durch Driicken des

Datei fnalyse  GIEY Einstellung

Datei Analyse  Bild

[Einstellung
[1:32.5]

Pfe||s nach OBEN A Datei fnalyse  Bild
oder UNTEN ¥ auf dem
Tastenfeld die Option
[Bild] wahlen, an-

schlieBend die MENU-/
EINGABE-Taste driicken.
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4. Bildeinstellungen vornehmen:

- Das Feld, das Sie
andernmaochten, er-
reichen Sie mit dem
Pfeil nach OBEN A
oder UNTEN V¥ auf
dem Tastenfeld.

- Zum Einstellen der Werte den Pfeil nach « LINKS /
RECHTS » auf dem Tastenfeld driicken.

Einstellung-Bild

Selbst ein.:
Einst.pernanent :None E
Palette :  Eisi
Saturierung Col:au
Windouwsdarst. :

Weitere Informationen (iber die Bildeinstellungen:
Palette/Farbe
Bestimmt die unechten Farben des thermalen Bildes.
Die Kamera hat 6 Farbpaletten zur Auswahl: Eisen,
Eisen invertiert, Regenbogen, Feder, Grau und Grau
invertiert.
Auto adjust/Automat. Temp.-Abgleich
Bestimmt die Funktion der A-Taste. Es stehen drei Opti-
onen zur Auswahl: Level und Span, Level, Spanne.
- Level und Span/mittlere Temperatur und
Temperaturspannweite
Die Kamera stellt Level (Helligkeit) und Spanne
(Kontrast) des Bildes automatisch optimal ein.
- Level
Die Kamera stellt das Level (Helligkeit) des Bildes
automatisch ein.
- Span
Die Kamera stellt die Spanne (Kontrast) des Bildes
automatisch ein.
Continuous adj / permanenter autom. Temperaturabgleich
Hier konnen Sie wéhlen, ob die Helligkeit und der
Kontrast des auf dem Bildschirm dargestellten Bildes
automatisch abgeglichen werden sollen.
- Level and Span
Helligkeit und Kontrast werden automatisch ab-
geglichen.
- Level
Die Helligkeit wird automatisch abgeglichen.
- None
Helligkeit und Kontrast werden nicht automatisch
abgeglichen.

Color scale
Hier wahlen Sie die Falschfarben fiir die Warmebildwie-
dergabe. Die Kamera bietet 6 Paletten: Iron, Iron inver-
ted, Rainbow, Feather, Grey und Grey inverted.
Saturation color
Hier stellen Sie ein, wie der Teil unterhalb des Tempera-
turbereichs der Farbskala dargestellt werden soll.
-0On
Als Bildsattigungsfarbe wird Griin oder Schwarz
eingestellt.
- Off
Keine Bildsattigungsfarbe eingestellt.
Windows style
Hier wahlen Sie den Stil des integrierten Men(isystems.
- Standard
Das integrierte Meniisystem wird im Standardstil
angezeigt.
- Skyblue
Das integrierte Mentisystem wird im Trendstil angezeigt.

Objektparameter einstellen
1. Driicken Sie die Menii-/ {lfpetei s pila_Einsteling
i

Eingabe-Taste. u

2. Durch Driicken des
Pfeils nach <« LINKS /
RECHTS » aufdemTas-
tenfeld das Analyseme-
ni [Analyse] wahlen.

3. Durch Driicken des
Pfeils nach OBEN A
bzw.UNTEN ¥ auf dem
Tastenfeld die Option
[Obj par] wihlen, an
schlieBend die MENU-/
EINGABE-Taste driicken.
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4. Objektparameter einstellen:

- Das Feld, das Sie __ Dbject Par.
andern mochten, er- b ject :
reichen Sie mit dem :

Pfeil nach OBEN A
oder UNTEN V¥ auf
dem Tastenfeld.

- Zum Einstellen der
Werte den Pfeil nach
< LINKS/RECHTS »
auf dem Tastenfeld
driicken.

5. AnschlieBend die vorgenommenen Anderungen
durch Driicken der MENU-/EINGABE-Taste speichern
oder das Menii durch Driicken von Taste C ohne
Speichern schlieBen.

Uber die Objektparameter:

Object Para

- Object
Hier wéhlen Sie das Analysetool, dessen Parameter
Sie dndern wollen. Sie kénnen wéhlen: ,Spot1-
10“, ,Areal-5“, ,Profile“ und ,Isotherm*“. Bei den
einzelnen Analysetools kénnen Sie unterschiedliche
Parameter einstellen.

- Emiss
Objekte mit verschiedener Oberflache haben auch
andere Emissionsgrade. Hier konnen Sie den Emis-
sionsgrad andern.

- Distance / Entfernung
Andere Objekte haben auch einen anderen Abstand zur
IR-Kamera. Hier konnen Sie die Entfernung andern.

Global Para / allg. Parameter

- Amb Temp / Umgebungs-/Hintergrundtemperatur
Hier geben Sie die Umgebungstemperatur ein.

- Humidity / Luftfeuchtigkeit
Hier geben Sie die Umgebungsfeuchtigkeit ein.

- Comp Obj / Objektvergleich
Hier konnen Sie die Temperatur eines Comp Obj1
und Comp Obj2 vergleichen. Als Obj1 und Obj2 kénnen

Spot(1-9), Cap(Spot10), Area(1-5), Profile oder Isotherm
gewahitwerden. Der Temperaturunterschied wird unten
rechts im Bildschirm angezeigt.

- Ref Temp
Dient zum Vergleich. Wenn hier ein Wert eingegeben
wird, kann die Kamera den Temperaturbezugswert
einstellen.

Analyseparameter einstellen

Dieser Themenbereich erklart, wie die Analyse-Tools
auf dem Thermalbild eingestellt werden.

1. Driicken Sie die Menti-/
Eingabe-Taste. u

2. Durch Driicken des
Pfeils nach < LINKS /
RECHTS » aufdemTas-
tenfeld das Setupmenii
[Einstellung] wahlen.

3. Durch Driicken des
Pfeilsnach OBEN A bzw.
UNTEN ¥ auf dem Tas-
tenfeld die Option
[Analyse] wéhlen, dann
die MENU-/EINGABE-
Taste driicken.

4. Analyseparameter einstellen:

Das Feld, das Sie
andernmochten, er-
reichen Sie mit dem
Pfeil nach OBEN A
oder UNTEN V¥ auf
dem Tastenfeld.

- Zum Einstellen der
Werte den Pfeil nach < LINKS / RECHTS » auf
dem Tastenfeld driicken.

5. AnschlieBend die vorgenommenen Anderungen
durch Driicken der MENU-/EINGABE-Taste speichem
oder das Menii durch Driicken von Taste C ohne
Speichern schlieBen.

Datei Analyse Bild

[Einstellung]

Einstellung-fAnalyse

Spot finden : Maximum
Bereich Mittelwert
Profile:
Isotherm type: Interval
Isothermbreite: GO
Isothermfarbe : Gruen
Alarm: aus

Alarm temp: 100C
Refferenztemp: oC
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Uber die Analyseparameter:
Capture Spot

Hier kdnnen Sie einstellen, dass Spot10 automatisch
den warmsten/kaltesten Punkt auf dem Bildschirm
verfolgen soll.

- Max
Spot10 verfolgt den wérmsten Punkt auf dem
Bildschirm.

- Min
Spot10 verfolgt den kéltesten Punkt auf dem
Bildschirm.

Area function

Hier stellen Sie die Art des Messwerts ein, der fiir einen
Bereich angezeigt werden soll, ein. Den Messwert
sehen Sie unten rechts im Bildschirm. Sind mehrere
Bereiche eingestellt, werden ihre Messwerte abwech-
selnd angezeigt.
- Max
Es wird die hochste Temperatur in dem Bereich
angezeigt.
- Min
Es wird die niedrigste Temperatur in dem Bereich
angezeigt.
- Average
Es wird die Durchschnittstemperatur des Bereichs
angezeigt.
Profile
- Horizontal
Die Profilanalyse wird auf horizontal eingestellt.
- Vertical
Die Profilanalyse wird auf vertikal eingestellt.

Isotherm type

Hier stellen Sie die Isothermen-Analyse ein. Es gibt
fiinf Modi: ,Dual Above“, ,Dual Below“, ,Above“,
,Below* und ,Interval®.

- Dual Above
Das Isothermenintervall und die Teile, deren Tempe-
raturen (iber der Obergrenze des Isothermeninter-
valls liegen, werden jeweils in einer anderen Farbe
dargestellt.

- Dual Below
DaslsothermenintervallunddieTeile,derenTempe-
raturen unter der Untergrenze des Isothermen-
intervalls liegen, werden jeweils in einer anderen
Farbe dargestellt.

- Above
Das Isothermenintervall und die Teile, deren Tem-
peraturen (iber der Obergrenze des Isothermeninter-
valls liegen, werden in der gleichen Farbe dargestellt.

- Below
Das Isothermenintervall und die Teile, deren
Temperaturen unter der Untergrenze des Isother-
menintervalls liegen, werden in der gleichen Farbe
dargestellt.

- Interval
Das Isothermenintervall wird in einer bestimmten
Farbe, alle anderen Teile werden im normalen
Falschfarbenmodus dargestellt.

Isotherm width

Hier stellen Sie die Breite des Isothermenintervalls
ein. Die Breite kann von 0,1 °C bis zur Obergrenze
des maximalen Temperaturmessbereichs unter dieser
Bedingung eingestellt werden.

Isotherm color

Hier stellen Sie die Farbe des Isothermenintervalls ein.
Verfligbare Optionen: ,Transparent®, ,Green“, ,Black®
und ,,White“.

Alert

Hier kdnnen Sie einen Temperaturalarm aktivieren bzw.
deaktivieren. Ist die Einstellung ,,0n“ gewéhlt, wird der
Temperaturmesswert von ,Spot 10“ rot dargestellt —
das bedeutet, er befindet sich im Alarmstatus —, wenn
unter [Spot] / [Setup-analysis] ,Maximum* eingestellt
wurde und die in ,Spot 10“ gemessene Temperatur
gleich oder hoher als die voreingestellte Alarmtempe-
ratur ist. Auch im umgekehrten Fall, also wenn ,Spot
10 unter [Spot] / [Setup-analysis] als ,Minimum“
eingestellt wurde und seine Temperatur gleich ist oder
unter der voreingestellten Alarmtemperatur liegt, wird
der Temperaturmesswert im Alarmmodus angezeigt.
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Alert temp

Hier stellen Sie den Temperaturgrenzwert fiir einen

LJAlarm® ein.
Correct temp

Hier wird der von der Kamera gemessene Temperatur-
wert unter bestimmten Umstinden zur Gewéahrleistung

der Messgenauigkeit korrigiert.

Punktanalyse

1. Driicken  Sie die
Menii-/Eingabe-Taste.

2. Durch Driicken des
Pfeils nach < LINKS /
RECHTS » auf dem
Tastenfeld das Analyse-
menii [Analyse] wahlen.

3. Durch Driicken des
Pfeils nach OBEN A
oder UNTEN ¥ auf dem
Tastenfeld die Option
[Spot] wéhlen, an-
schlieBend die MENU-/
EINGABE-Taste drticken.

4. Punktanalyse einstellen:

- Mit dem Pfeil nach
OBEN A 0. UNTEN ¥
auf dem Tastenfeld
einen Punkt wahlen,
dann die MENU-/EIN-
GABE-Taste driicken.
Es erscheinen ein
oder mehrere Kreuzcursor.

Datei JEINES  Bild Einstellung

- Spot 10 verfolgt automatisch den warmsten bzw.

kaltesten Punkt auf dem Bildschirm.

5. Analysepunkt
verschieben:

- Beginnen Sie mit
Schritt 1 fiir das Ein-
stellen einer Punkt-
analyse.

- Der aktuelle Analysepunkt erscheintin der Status-
anzeige.

- Den aktivierten Punkt kdnnen Sie mit Pfeil nach
OBEN A, UNTEN ¥, <« LINKS und RECHTS » auf
dem Tastenfeld verschieben.

- Der Temperaturwert des aktuellen Punkts wird ver-
groBert.

- Sie konnen die hochste/niedrigste Temperatur des
Bildes messen.

Bereichsanalyse

1. Driicken Sie die Menii-/
Eingabe-Taste.

2. Durch Driicken des
Pfeils nach <« LINKS /
RECHTS » aufdemTas-
tenfeld das Analyse-
menli [Analysis] wahlen.

3. Durch Driicken des
Pfeils nach OBEN a
bzw. UNTEN ¥ auf dem
Tastenfeld die Option
[Bereich] wéhlen, dann
die MENU-/EINGABE-
Taste driicken.

4. Analysebereich
einstellen:

- Mit dem Pfeil nach
OBEN A oder UNTEN
vaufdemTastenfeld
einen Bereich wah-
len, dann die MENU-/
EINGABE-Taste -
driicken. Auf dem |
Bildschirm erschei-
nen ein oder mehrere
Késten. e

Unten rechts ist ein Messwert zu sehen. Das ist
die hochste/niedrigste/ durchschnittliche Tempe-
ratur des aktuellen Bereichs.

Datei JMNUEE Bild Einstellung

By |

|
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5. Analysebereich verschieben:
- Beginnen Sie mit
Step 1 fiir das Ein-
stelleneiner Bereichs-
analyse.

- InderStatusanzeige
erscheint der aktuelle
Analysebereich.

- Den aktuellen Bereich kdnnen Sie mit Pfeil nach
OBEN A, UNTEN ¥, <« LINKS und RECHTS » auf
dem Tastenfeld verschieben.

- Mit bestimmten Tastenkombinationen Idsst sich
auch die Form des aktuellen Bereichs dndern.

- Durchgediickthalten der Taste OBEN 4 oderUNTEN
¥ und anschlieBendes Driicken der Tasten « LINKS
bzw. RECHTS » kann das Bereichsfeld insgesamt
vergroBert, verlangert oder verbreitert werden.

Profilanalyse

1. MENOU-/EINGABE-
Taste driicken.

2. Durch  Driicken des
Pfeils nach « LINKS /
RECHTS » auf dem Ta-
stenfeld das Analyse-
ment wahlen.

3. Durch Driicken des
PfeilsnachOBEN A bzw.
UNTEN ¥ auf dem Tas-
tenfeld die Option wéh-
len, dann die MENU-/
EINGABE Taste driicken.
Auf dem Bildschirm er-
scheint ein Profil.

4. Profilanalyse ver-

schieben:

-Beginnen Sie mit dem
Schritt 1 fiir das Einstel-
len einer Profilanalyse.
- Nun kénnen Sie das Profil mit dem Pfeil nach OBEN

A oder UNTEN V¥ (Horizontal) bzw. < LINKS /
RECHTS » (Vertikal) auf dem Tastenfeld verschieben.

Temperaturverteilung

5. Den Kreuzcursor auf

dem Profil verschieben:

- Beginnen Sie mit

Schritt 1 fiir das Ein-

stellen einer Profil-
analyse.

- Den Kreuzcursor

Isothermen-Analyse

1. MENU-/EINGABE-Taste
driicken.

2. Durch Driicken des
Pfeils nach « LINKS /
RECHTS » auf dem
Tastenfeld das Analyse-
men(i [Analyse] wahlen.

3. Mit dem Pfeil nach
OBEN 4 bzw.UNTEN ¥
die Option [Isotherm]
wéhlen, dann die
MENU-/EINGABE Tas-
te driicken. Die betref-
fenden Bereiche wer-
den farbig markiert.

4. 1sothermenbereich
einstellen:

- Beginnen Sie mit
Schritt 1 fiir das Ein-
stellen einer Isother-
men-Analyse.

- InderStatusanzeige
erscheint die Mel-
dung [Isotherm].

- Nun mit dem Pfeil RS AR

Temperatur des Kreuzcursor
konnen Sie mit dem Pfeil nach « LINKS/RECHTS »
(Horizontalprofil) bzw. OBEN A oder UNTEN ¥
(Vertikalprofil) auf dem Tastenfeld verschieben.

Bild Einstellung

nach OBEN A bzw. UNTEN ¥ auf dem Tastenfeld
den Isothermenbereich wahlen.

- Unten rechts erscheinen IL (Isotherm Low) und
IH (Isotherm High). IL ist die Unter-, IH die Ober-
grenze des Isothermenbereichs.
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Analysetools einzeln entfernen
1. MENU-/EINGABE-Taste driicken.

2. Durch Driicken des
Pfeils nach < LINKS /
RECHTS » auf dem

2. Durch Driicken des
Pfeils nach < LINKS /
RECHTS » auf dem
Tastenfeld das Datei-
mend [Datei] wahlen.

Tastenfeld das Analyse- 3. Durch Driicken des
menii [Analyse] wahlen. Pfeils nach OBEN A
- InderStatusanzeige bzw.UNTEN ¥ auf dem

erscheint das aktu-
elle Analysetool.

- WenndasAnalysetool, das Sie entfernen machten,
bereits das aktuelle Analysetool ist, konnen Sie

diesen Schritt und Schritt 3 {iberspringen.

3. Wahlen Sie das Analysetool, das Sie entfernen mdchten.

4. Zum Entfernen Taste C driicken.

Alle Analysetools entfernen

1. MENU-/EINGABE-Taste
driicken.

2. Durch Driicken des
Pfeils nach < LINKS /

Datei JEYURS Bild Einstellung

Tastenfeld die Option
[speichem] wahlen,dann
das Bild durch Drii-
cken der MENU/EIN-
GABE-Taste speichern.

IEZS Analyse  Bild Einstellung |
o !

Einstellungen zur Bildspeicherung

1. MENU-/EINGABE-Taste
driicken.

2. Durch Driicken des
Pfeils nach < LINKS /
RECHTS » auf dem
Tastenfeld das Setup-

RECHTS » auf dem mendi  [Einstellung]

Tastenfeld das Analy- wahlen.

semeni  [Analyse] 3. Durch Driicken des

wahlen. Pfeils nach OBEN 4 o.
3. Durch Driicken des UNTEN ¥ auf dem Tas-

Pfeils nach OBEN A tenfeld die Option [Datei]

bzw. UNTEN V¥ die Op-
tion [Alles abl.] wah-
len, dann die MENU-/
EINGABE-Taste drii-
cken. Es werden alle

w'aihlgn und dann die
MENU-/EINGABE-Taste
driicken.

Datei finalyse Bild NN
[1:32.5]

4. Speichereinstellungen dndern:

Analysetools entfernt. - Das Feld, das Sie [Einstellung-Datei
andernmochten,er- | Datei tup : [EETEN
. . : f i Speichern typ: Nummer
Bild speichern reichen Sie  mit |y eit 1L 2P

dem Pfeil nach
OBEN A oder UNTEN ¥ auf dem Tastenfeld.

- Zum Einstellen der Werte den Pfeil nach « LINKS/
RECHTS » auf dem Tastenfeld driicken.

Sie kdnnen ein Bild im Men(isystem speichern, nachdem
Sie es eingefroren haben, alternativ aber auch direkt, d.
h. ohne es vorher einzufrieren, indem Sie 3 Sekunden
lang die Taste S auf dem Tastenfeld gedriickt halten,
wahrend sich die Kamera im Null-Modus befindet.

1. MENU-/EINGABE-Taste driicken.
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Uber die Speichereinstellungen:

File Type

Hier stellen Sie die Art der Bildaufnahme ein.

- Both: Es werden Wérmebild und Sichtbild gespei-
chert wenn die DigiCam aktiviert ist.

- IR:Es wird nur das Warmebild gespeichert wenn die
IR-Funktion aktiv ist.

- CCD: Es wird nur das Sichtbild gespeichert wenn
nur die DigiCam aktiv ist.

Storage Type

Hier konnen Sie wéahlen, wie die Dateinummern zuge-

wiesen werden sollen.

- Number: Mit dieser Funktion konnen Sie mehrere
Bilder gleichzeitig speichern.

- Time: Diese Funktion kann zur Festpunktbeobach.
tung eines Objekts verwendet werden.

Number / Time

Mit dieser Option kdnnen Sie die Einstellung des Spei-

chertyps dndern. Wenn Sie als Speichertyp [Number]

einstellen, kénnen Sie in dieser Option auf den Para-
meter [Number] zugreifen. Wenn Sie als Speichertyp

[Time] einstellen, steht in dieser Option der Parameter

[Time] zur Verfiigung.

- Number: Hier kénnen Sie die Zahl der Bilder ein-
stellen, die hintereinander gespeichert werden
sollen. Uber das Menii ,Datei“ -> ,speichern®
wird eineBildfolge entsprechend dereingegebenen
Zahl gespeichert. Durch Driicken der Taste ,S“
wird nur ein Bild gespeichert.

- Time: Hier konnen Sie die Zeit fiir das Aufnahme-
intervall einstellen. Uber das Menii ,Datei“ ->
»speichern® des eingegebenen Zeitintervalls ge-
speichert. Durch Driicken der Taste ,S“ wird nur
ein Bild gespeichert. Der Speichervorgang hangt
ab von den eingestellten Analyseparametern
(je weniger, desto schneller) und liegt zwischen
1,1/1,8 Sekunden.

Stimmaufzeichnung mit Bild verkniipfen

Sie konnen ein Bild mit einem Sprachmemo von bis
zu 40 Sekunden verkniipfen.

1. Das Headset am Kamerageh&use anschlieBen.

2. Das gewiinschte Bild einfrieren, dann die MENU-/

EINGABE-Taste driicken.
3. Durch Driicken des (e T
Pfeils nach <« LINKS / A
RECHTS » auf dem
Tastenfeld das Datei-

menii [File] wéhlen.

4. Durch Driicken des
Pfeils nach OBEN a
bzw. UNTEN ¥ auf dem
Tastenfeld die Option
[Aufzeichnung] wahlen,
dann die MENU-/EIN-
GABE-Taste driicken.

- Im LCD-Monitor er- L
scheint die Meldung [Vmce Recording].

5. In das Mikrofon des Headsets sprechen. Um die
Aufzeichnung zu beenden, Taste C driicken.

6. Das Bild speichern.

IIXZH Analyse  Bild Einstellung

/\ Die Speicherkapazitit sinkt nicht,
wenn Sie einem Bild einen Sprach-
kommentar hinzufiigen.

Textkommentar zum Bild hinzufiigen

1. Das gewiinschte Bild einfrieren, dann die MENU-/
EINGABE-Taste driicken.

2. Durch Driicken des
Pfeils nach < LINKS /
RECHTS » auf dem
Tastenfeld das Datei-
menii [Datei] wahlen.

IIXEH Analyse  Bild Einstellung |
[1:42.2]

3. Durch Driicken des
Pfeils nach OBEN A o.
UNTEN ¥ auf dem Tas-
tenfeld die Option
[Kommentar] wahlen,
dann die MENU-/EIN-
GABE-Taste driicken.

-Im LCD-Monitor (oder Eese————==tmmi
Bildsucher) erscheint das Fenster [Kommentar].
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4. Mit dem Pfeil nach
OBEN A oder UNTEN ¥
auf dem Tastenfeld
einen Kommentar aus-
wahlen, dann die
MENU-/EINGABE Tas-
te driicken, um einen
Textkommentar hinzuzufligen.

5. Das Bild speichern.

06. WIEDERGABE UND LGSCHEN

Bilder offnen

Sie konnen sich die gespeicherten Bilder auf dem LCD-
Monitor anschauen und analysieren.

1. Driicken Sie die Menti-/
Eingabe-Taste.

2. Durch Driicken des
Pfeils nach < LINKS /
RECHTS » auf dem
Tastenfeld das Datei-
menti [Datei] wéhlen.

3. Durch Driicken des
Pfeils nach OBEN A o.
UNTEN ¥ auf dem Tas-
tenfeld die Option
[Offnen] wahlen, dann
die MENU-/ EINGABE-
Taste driicken.

4. Durch Driicken des
Pfeils nach OBEN A o.
UNTEN V¥ das gew(in-
schte Bild wéhlen,
dann das Bild durch
Driicken der MENU-/
EINGABE-Taste offnen.

Durch Driicken des
Pfeils nach « LINKS /

28041812 {DIR>

RECHTS » konnen Sie das jeweilige Bild auch direkt

offnen.

Bilder auswahlen

1. Wenn Sie im Dateimenti [File] die Option [Open] oder
[Delete] wahlen, erscheint unten links auf dem Bild-
schirm eine Meldung wie unten dargestellt.

69141330.SAT 001
2006-10-12 010

Dateiname des Erstellungsdatum Gesamtzahl der Folgenummer
aktuellen Bildes ~ des Bildes  Bilder im Ordner  des Bildes

2. Wenn sich das Bild, das Sie 6ffnen oder I6schen
mochten, nicht in dem aktuellen Ordner befindet,
driicken Sie auf dem Tastenfeld den Pfeil nach
OBEN 4, bis die folgende Meldung erscheint:

<DIR>
Enter or Cancel

3. Mit der MENU-/EINGABE-Taste ein Verzeichnis
wéhlen oder mit der Taste Cancel abbrechen. Wenn
Sie mit der MENU-/ EINGABE-Taste ein Verzeichnis
gewahlt haben, erscheint auf dem Bildschirm eine
Meldung.

20061012 <DIR>

001 / 002 / 003——|
| I
| |

Ordnername des  Gesamtzahl der Folgenummer ~ Nummer des
aktuellen Ordners Bilder im Ordner  des Bildes Ordners

4. Mit dem Pfeil nach OBEN A oder UNTEN ¥ auf dem
Tastenfeld einen Ordner wéhlen, dann Schritt 1 wieder-
holen und in dem gewahlten Ordner ein Bild wéhlen.
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Uber die Datei- und Ordnernummern

Die Ordner werden nach inrem Erstellungsdatum benannt.
Die Bilder werden nach der Folgenummer benannt.

s (] -]

69155526 69155527 69155540 69155541
Waurzel- 2006101
verzeichnis v
O]
Speichers =
20061012 69155633 69155634 69155671 69155672
- N I P
69156667 69156668 69156687 69156689
20061020,
- I Y
69156667 69156668 69156694 69156695
120061021,

Das ist das Datum,
an dem der Ordner
erstellt wurde

/\ Diese Ordner auf der CF-Karte priift die Ka-
mera bei jedem Einschalten. Wenn noch kein
solcher Ordner existiert, erstellt sie einen
Ordner, der nach dem Datum der Systemuhr
benannt wird. Das ist der Standardordner,
in dem alle Bilder gespeichert werden. Der
Standardordner édndert sich in den zuletzt von
Ihnen gewiéhlten Ordner; in ihm werden alle

Bilder gespeichert.

Wiedergabe der Sprachvermerke

1. Das Headset am Ka-
meragehéuse ansch-
lieBen.

2. Das gewiinschte Bild
offnen.

3. Die MENU-/EINGABE-
Taste driicken und an-
schlieBend mit dem
Pfeil nach < LINKS /
RECHTS » auf dem
Tastenfeld das Datei-
menii [Datei] wahlen.

IEXZ3] Analyse  Bild Einstellung I}

ofnen b
Speichern
Lischen b

Aufze ichnung

Komnentar. .»

4. Durch Driicken des
Pfeils nach OBEN A o.
UNTEN ¥ auf dem Tas-
tenfeld die Option [Voice
Play] wéhlen, anschlie-
Bend die MENU-/EIN-
GABE-Taste drticken.

iy b

T — TN T T J!LEE

-Im LCD-Monitor (oder Bildsucher) erscheint die
Meldung [Playing Record)].

5. Beenden konnen Sie die Wiedergabe des Sprech-
kommentars mit der Taste C.

Bilder loschen

/\ Beachten Sie bitte, dass Bilder, die geldscht
worden sind, nicht wiederhergestellt wer-
den kdnnen. Gehen Sie bitte daher beson-

ders vorsichtig vor.

1. Die MENU-/EINGABE-
Taste driicken und an-
schlieBend mit dem
Pfeil nach « LINKS /
RECHTS » auf dem
Tastenfeld das Datei-
meni [Datei] wahlen.

2. Durch Driicken des
Pfeils nach OBEN A
bzw.UNTEN ¥ auf dem
Tastenfeld die Option
[Loéschen] wahlen, dann
die MENU-/ EINGABE-
Taste driicken.

3. Das gewiinschte Bild
wabhlen, dann die ME-
NU-/EINGABE-Taste
driicken, um es zu 16-
schen

4. Um das Menii zu ver-
lassen, Taste C driicken.

IR Analyse  Bild Einstellung
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07. BILDER AUSLESEN

An einen Monitor anschlieBen

Mit einem videokompatiblen Monitor, der (iber das Video-
kabel (im Lieferumfang enthalten) angeschlossen wird,
konnen Sie sich die aufgenommenen Bilder ansehen
und analysieren.

1. Die IR-Kamera ausschalten

2. Das Videokabel am Video-
Ausgang der IR-Kamera
anstecken.

3. Dasandere Ende desVideo-
kabelsindenVideo-Eingang

des Monitors stecken.

4. Den Monitor und die IR-Kamera einschalten.

Verbindung mit dem PC herstellen

SchlieBen Sie das mitgelieferte USB-Kabel an den USB-
Port des PCs und die Anschlussstelle der multifunktiona-
len Docking-Station an. Sie miissen weder den PC noch
die Kamera ausschalten, wéhrend Sie diese Verbindung
herstellen. Wenden Sie sich ggf. an Ihren Computer-Ad-
ministrator, um mehr (ber die exakte Position Ihres USB-
Ports zu erfahren. Der USB-Port wird nur fiir die optional
erhéltliche Real-Time Software verwendet.

08. VERBINDUNG HERSTELLEN UND AUSLESEN

Aufladen iiber das Ladegerat

Der Akku kann mittels des mitgelieferten Adapters auf-
geladen werden.

1. SchlieBen Sie das Kabel an das Aufladegerét an und
stecken Sie das andere Ende in die Steckdose.

2. Die LED blinkt wahrend des gesamten Ladevorgangs
und brennt dauerhaft griin, wenn der Vorgang beendet
ist. Ziehen Sie den Adapter nach Beendigung des Lade-
vorgangs wieder aus.

Die Batterie sollte ausschlielich mit einem entspre-
chenden Ladegerat aufgeladen werden.

Anschluss an einen Monitor

Sie konnen das mitgelieferte Videokabel verwenden, um
lhre Aufnahmen an einem video-kompatiblen Monitor
anzuschauen oder zu analysieren.

1. Die IR-Kamera ausschalten

2. Das Videokabel am Video-Ausgang der IR-Kamera an-
stecken.

3. Das andere Ende des Videokabels in den Video-Ein-
gang des Monitors stecken.

4. Den Monitor und die IR-Kamera einschalten.

Verbindung mit dem PC herstellen

Das USB-Kabel (im Lieferumfang enthalten) am USB-
Port des Rechners und am Kameraanschluss anschlie-
Ben. Sie brauchen den Rechner und die Kamera beim
AnschlieBen nicht auszuschalten. Wo sich an lhrem
Rechner der USB-Port befindet, schlagen Sie bitte im
Handbuch zu lhrem Rechner nach.

USB-PORT

USB-KABEL

Direkt iiber USB herunterladen

Sie kénnen die mit der IR-Kamera aufgenommenen Bil-
der direkt tiber die USB-Schnittstelle auf einen Rechner
libertragen.

1. Das Menii offnen,
dann ,Einstellung—
Sonstige“ wéhlen.

2. Die Option ,USB -
Mode“ wéhlenund
von ,Real Time*“
auf ,FlashDisk"
umstellen.

Illuninator:
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3. Die IR-Kamera iiber die USB-Schnittstelle am
Rechner anschlieBen.

4. Das Betriebssystem erkennt die Kamera als Massen-
speicher. Die Kamera wird ohne zusétzlichen Treiber
auf Inrem Rechner installiert.

5. Wenn die Installation abgeschlossen ist, suchen Sie
das Kamera-Verzeichnis.

/\ Wenn Sie im geschlossenen Zustand den
USB-Modus von ,FlashDisk* auf ,,Real-
Time* (Echtzeit) umstellen, miissen Sie Ihren
Rechner ggf. neu booten.

Treiber installieren (gilt nur fiir Real-Time Software)

SchlieBen Sie das mitgelieferte USB-Kabel an den
USB-Port Ihres PCs und den USB-Anschluss der IR-
Kamera an. Legen Sie die SAT Real-Time CD in das
CD-Laufwerk lhres PCs.

/\ Windows XP Professional / Windows 2000
Benutzer miissen sich ggf. zuerst als Com-
puter System Administrator einloggen, um
Programme zu installieren.

1. Nach wenigen Augen-
blicken erscheint fol-
gende Meldung.

) Found New Hardware
EZ-LUSB Fx2

2. Wahlen Sie [Dieses mal
nicht], klicken Sie auf
[Nachster >].

3. Wahlen Sie [Installieren
von einer Liste oder
einem bestimmten Ort
[Fortgeschritten] und
klicken Sie nun auf
[Nachster>].

4. Wahlen Sie [SchlieBen
Sie diesen Ort in die
Sucheein:]undklicken
Sieauf[browse].Suchen
Sie das Verzeichnis des
Treibers und Klicken Sie
auf [Ok], um zum vor-
herigen Fenster zurlick- [z
zukehren. Klicken Sie
dann auf [N&chster >].

5. Ignorieren Sie die an-
gezeigte Fehler-/Warn-
meldung und klicken
Sie auf [Trotzdem
fortfahren].

6. Klicken Sie auf [Been-
den], um die Treiber-
installation zu beenden.

09. PFLEGE UND WARTUNG

Kameragehduse

Wischen Sie das Gehduse mit einem sauberen, weichen
Tuch oder Brillenputztuch ab.

Linse

Benutzen Sie zunéchst einen Blasepinsel (kleiner Blase-
balg), um Staub und Schmutz von der Linse zu entfernen
und verwenden Sie anschlieBend ein weiches Tuch, um
eventuelle Riickstande von der Linse sanft zu entfernen
LCD-Monitor

Benutzen Sie zundchst einen Blasepinsel, um Staub und
Schmutz zu entfernen und verwenden Sie, wenn notig,
ein weiches Tuch, um hartnéckige Riickstdnde von dem
Monitor sanft zu entfernen. Uben Sie nie Druck auf den
LCD-Monitor aus und versuchen Sie nicht Riickstinde
mit Kraft wegzureiben. Dies kann zu einer Beschédigung
der Linse bzw. weiteren Problemen fiihren.
/\ Verwenden Sie niemals Verdiinner, synthe-
tische Reinigungsmittel oder Wasser, um die
Kamera zu reinigen.
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10. FEHLERSUCHE UND BEHEBUNG

Problem

Ursache

Ldsung

Die Kamera funktioniert nicht.

Die Kamera ist nicht eingeschaltet.

Schalten Sie die Kamera ein.

Zu wenig Strom.

Laden Sie den Akku voll auf.

Schlechter Kontakt zwischen der
Kamera und der Batterie.

Wischen Sie die Kontakte mit einem
sauberen, trockenen Tuch ab.

Die Kamera zeichnet nicht auf.

Interner Speicher ist voll.

Sichern Sie die Bilder auf einem
PC und Idschen Sie diese dann.

Interner Speicher ist nicht
korrekt formatiert.

Formatieren Sie den internen
Speicher im FAT16 Format.
Achtung: Alle gespeicherten
Bilder werden geldscht!

Der Akku ist schnell verbraucht.

Die Kapazitét des Akkus ist ein-
geschrénkt, weil er (iber einen
Zeitraum von einem Jahr oder
langer nicht benutzt wurde.

Wechseln Sie den Akku gegen
einen neuen Akku aus.

Akku-Lebensdauer (iberschritten.

Akku auswechseln.

Der Akku lasst sich nicht laden.

Schlechter Kontakt zwischen der
Batterie-Anschliissen und dem
Ladegerét.

Reinigen Sie die Anschliisse mit
einem sauberen Tuch und ver-
binden Sie das Kabel mit dem Lade-
gerat. Achten Sie darauf, dass der
Stecker fest in der Dose sitzt.

Akku-Lebensdauer {iberschritten.

Akku auswechseln.

11. EMISSIONSGRAD-TABELLE

Material Temperatur | Emissionsgrad Material Temperatur | Emissionsgrad
(°C) (Zirka-Angaben) (°C) (Zirka-Angaben)

Aluminium Kupfer

Poliertes Aluminium | 100 0,09 Kupferspiegel 100 0,05

Hand_eljs.[]bliche 100 0.09 Starkes Kupferoxid | 25 0,078

Aluminiumfolie ’ Fliissiges Kupfer | 1080~1280| 0,16 ~ 0,13

Elektrolytisches, Messing

verchromtes 25 ~ 600 0,55 : :

Aluminiumoxid Messingspiegel 28 0,03

Mildes Aluminiumoxid | 25 ~ 600 | 0,10 ~0,20 | | Messingoxid 200 ~600 | 0,61 ~0,59

Chrom

Aumimumod | 25600 | 0,30~ 040 Poliertes Chrom | 40 ~ 1090 | 0,08 ~ 0,36

Kupfer Gold

Kupferoxid 800~ 1100 0,16 ~0,13 | | Goldspiegel | 230-~630 | 0,02
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11. EMISSIONSGRAD-TABELLE

Material

Eisen

Poliertes Gusseisen

Verarbeitetes
Gusseisen

Poliertes,
angelassenes Eisen

Polierter Stahlbarren

Roher,
geschweiBter Stahl
Oberflachen
Eisenoxid

Volistandig

verrostete Oberflache
Gewalzte Eisenplatte
Oxidierter Stahl

Gusseisen
(oxidiert bei 600°C)

Stahl
(oxidiert bei 600°C)

Elektrolytisches
Eisenoxid

Eisenplatte

Gusseisen,
schweres Eisenoxid

Angelassenes Eisen,
Eisenoxid

Schmelzoberflache

Geschmolzenes
Gusseisen

Geschmolzener
Baustahl

Fliissigstahl
Reines Eisenerz
Silber

Poliertes Silber

Temperatur
(°C)

200

20

40 ~ 250
770 ~ 1040
945 ~ 1100

20

22

100
198 ~ 600

198 ~ 600

125 ~ 520

500 ~ 1200
925 ~ 1120
25

40 ~ 250
22
1300 ~ 1400

1600 ~ 1800

1500 ~ 1650
1515~ 1680

100

Emissionsgrad
(Zirka-Angaben)
0,21
0,44

0,28
0,52 ~ 0,56
0,52 ~ 0,61

0,69

0,66

0,74
0,64 ~ 0,78

0,79
0,78 ~ 0,82
0,85~ 0,89
0,87 ~ 0,95
0,80
0,95
0,94
0,29
0,28
0,42 ~ 0,53
0,42 ~ 0,45

0,05

Material

Nickel

Nickelchrom
(hitzebestandig)

Nickelchrom
Legierung

Nickelchrom legiert
(hitzebestandig)

Nickelsilber Legierung
Blei

Reines Blei
(nicht oxidiert)

Edelstahl

18-8

304 (8Cr, 18Ni)
310 (25Cr, 20Ni)
Zinn

Fertige Zinnplatte
Stark oxidiert
Zink

Oxidiert bei 400°C

Galvanisierte, glan-
zende Eisenplatte

Asche Zinkoxid
Magnesium
Magnesia

Hg

Nickel

Poliert, galvanisiert

Galvanisiert
Nickeldraht
Vernickelt (oxidiert)

Temperatur
(°C)

50 ~ 1000

50 ~ 1040

50 ~ 500
100

125 ~225

25
215~490
215~520

100
0~200

400
28
25

275 ~ 825
0~100

25

20
185~1010
198 ~ 600

Emissionsgrad
(Zirka-Angaben)

0,65 ~ 0,79

0,64 ~ 0,76

0,95 ~ 0,98
0,14

0,06 ~ 0,08

0,16
0,44 ~ 0,36
0,90 ~ 0,97

0,07
0,60

0,01
0,23
0,28

0,55 ~ 0,20
0,09 ~0,12

0,05
0,01
0,09~0,19
0,37 ~0,48
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11. EMISSIONSGRAD-TABELLE

Material

Nichtmetallische Mat
Ziegelstein
Brandziegel

Graphit
(lampenschwarz)

Porzelanemaille
(weiB)
Asphaltum

Glas (Oberflache)
Calcimine

Eiche
Kohlestiick
Isolationsstiick
Blech

Glasrohr
Schlaufentyp

Porzelanemaille
Produkte

Porzelanemaille
Designs

Feste Materialien
Keramik (Vase)

Film
Hitzebestandiges Glas

Temperatur

(°C)
erialien

1100

1100
96 ~ 225

18

0~200
23
20
20

200 ~ 540

Emissionsgrad
(Zirka-Angaben)

0,75
0,75

0,95

0,90

0,85
0,94
0,90
0,90
0,85
0,91 ~ 0,94
0,88 ~ 0,90
0,90
0,87

0,90

0,83 ~ 0,95

0,80 ~ 0,93
0,90

0,90 ~ 0,93
0,85 ~ 0,95

Material

Nichtmetallische Mat
Glimmer
Flume mica
Glas
Halbleiter

Transistor
(kunststoffversiegelt)

Transistor
(metall Diode)

Pulse transmission
Ebene Kreideschicht
Oberste Schlaufe

Elektrische Materialien

Epoxyglasplatte
Epoxyhydroxy-
benzolplatte

Vergoldetes
Kupferblech

Gelotetes,
beschichtes Kupfer

Zinkbeschichter
Bleidraht

Messingdraht

Block talcum
terminal

Temperatur
(°C)
erialien

Emissionsgrad
(Zirka-Angaben)

0,94 ~ 0,95
0,90 ~ 0,93
0,91 ~ 0,92
0,80 ~0,90

0,30 ~0,40

0,89 ~0,90
0,91 ~0,92
0,88 ~0,93
0,91 ~0,92
0,86
0,80
0,30
0,35
0,28
0,87 ~0,88
0,87
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12. SPEZIFIKATIONEN

Warmebild
Gesichtsfeld

24°x18°/0,3 m (mit 35-mm-Linse)

geometrische Auflésung (IFOV)

1,3 mrad

Warmeempfindlichkeit

80 mK bei 30 °C

Bildwiederholfrequenz

50/60 Hz ohne Zeilensprung

Fokus

manuell

elektronischer Zoom

1x-8x (in Schritten von 0,1x)

Detektortyp Focal Plane Array (FPA), ungekihlter Mikrobolometer 320 x 240 Pixel
Spektralbereich 7,5 bis 13 pm
Sichtbild

integriertes Digitalvideo
Bildanzeige
Video-Ausgang

640 x 480 Pixel, Vollfarbe

PAL oder NTSC (optional) Composite Video

Bildsucher

integriert, hochauflésender Farb-LCD (TFT)

externer Display

3,5”-LCD mit integrierter Fernbedienung

Messung
Temperaturbereich Bereich1 -20 bis +180 °C, (-4 bis +356 °F)
p Bereich2 +160 bis 600 °C, (+320 bis 1112 °F)
Genauigkeit +2 °C, =2 % vom Messwert
(bis zu 10 verschiebbar), manuelle oder
Punkt automatische Platzierung sowie Messwert
flir max., min., durchschnittliche Temperatur
im Bereich
Messmodus
Bereiche (bis zu 5 verschiebbare Kéasten)
Isotherme Reporting-Software
Linienprofil Typll
Emissionsgradkorrektur variabel von 0,01 bis 1,00 (0,01-Schritte)

Korrektur der Umgebungstemperatur automatisch
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12. SPEZIFIKATIONEN

Bildspeicherung
Typ

internes Flash Memory (128 MB)

Dateiformate Warmebild

SAT-Format, 14 bit Messdaten inklusive

Dateiformate Sichtbild

CCD-Format

Sprechkommentar zu Bildern

40 s digitaler Sprachclip, Speicherung zus. mit betreffendem Warmebild

Textkommentar zu Bildern

vordefinierter Text, Auswahl und Speicherung zusammen mit dem Bild

Laserpointer

Klassifikation Klasse 2

Typ Semiconductor AlGalnP Diode Laser, 1mw/635 nm red
Akkusystem

Typ Li-lon, aufladbar, vor Ort auswechselbar

Betriebszeit 2,5 Stunden Dauerbetrieb

Ladesystem externes intellig. Ladegerat, 1 Steckplatz
Umgebungsbedingungen

Betriebstemperatur -15 bis +50 °C (5 bis +122 °F)

Lagertemperatur -40 bis +70 °C (-40 bis +122 °F)

Feuchtigkeit Betrieb und Lagerung 10 % bis 95 %, nichtkondensierend
Schutzart IP 54

Schock im Betrieb: 25 g

Vibration im Betrieb: 2 g

Physikalische Daten

Gewicht 1,08 kg

Abmessungen (HxBxT) 184,4 mm x 89,1 mm x 162,9 mm, (7,3” x 3,5” x 6,4”’) Kameragehéuse
Stativmontage 1/4” - 20

Schnittstelle

USB 2.0 Download Bilder und Echtzeit Warmevideo
Video-Ausgang Composite Video

RS-232 Fernsteuerung mit Rechner
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01. READ THIS FIRST

Test Shots

Before you try to shoot important subjects, we high-
ly recommend that you shoot several trial images to
confirm that the IR camera is operating and being
operated correctly.

Please note that TROTEC, its subsidiaries and affilia-
tes, and its distributors are not liable for any conse-
quential damages arising from any malfunction of an
IR camera or accessory that results in the failure of
an image to be recorded or to be recorded in a format
that is machine readable.

Warning Against Copyright Infringement
Safety Precautions

Before using the camera, please ensure that you read
and understand the safety precautions described
below. Always ensure that the IR camera is operated
correctly.

The safety precautions noted on the following pages
are intended to instruct you in the safe and correct
operation of the IR camera and its accessories to pre-
vent injuries or damage to yourself, other persons and
equipment.

Warnings

Read on to learn about using IR camera properly.

- Avoid damaging eyesight

/\ Do not trigger the laser pointer in human or

animal eyes. Exposure to the laser produced
by the laser pointer may damage eyesight.

- Do not disassemble

Do not attempt to disassemble or alter any part of
the equipment that is not expressly described this
guide.

- Stop operating immediately if it emits smoke or
noxious fumes
Failure to do so may result in fire or electrical shock.
Immediately turn the IR camera’s power off, remove
the IR camera battery or unplug the power cord from

the power outlet. Confirm that smoke and fume
emissions have ceased.

- Stop operating immediately if it is dropped or the
casing is damaged

Failure to do so may result in fire or electrical shock.
Immediately turn the IR camera’s power off, remove
the IR camera battery or unplug the power cord from
the power outlet.

- Do not use substances containing alcohol, benzene,
thinners or other flammable substances to clean or
main the IR camera.

The use of these substances may lead to fire.

- Remove the power cord on a regular periodic basis and
wipe away the dust and dirt that collects on the plug, the
exterior of the power outlet and the surrounding area

In dust, humid or greasy environments, the dust that
collects around the plug over long periods of time
may become saturated with humidity and short-
circuit, leading to fire.

- Do not handle the power cord if your hands are wet

Handling it with wet hands may lead to electrical
shock. When unplugging the cord, ensure that you
hold the solid portion of the plug. Pulling on the fle-
xible portion of the cord may damage or expose the
wire and insulation, creating the potential for fires
and electrical shocks.

- Do not cut, alter or place heavy items on the power
adapter cord

Any of these actions may cause an electrical short
circuit, which may lead to fire or electrical shock.

- Use only the recommended power accessories

Use of power sources not expressly recommended for
this IR camera may lead to overheating, distortion of
the IR camera, fire, electrical shock or other hazards.

- Do not place the batteries near a heat source or
expose them to direct flame or heat

Neither should you immerse them in water. Such
exposure may damage the batteries and lead to the
leakage of corrosive liquids, fire, electrical shock,
explosion or serious injury.

Operating manual —
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- Do not attempt to disassemble, alter or apply heat to
the batteries

This is serious risk of injury due to an explosion.
Immediately flush with water any area of the body,
including the eyes and mouth, or clothing, that comes
into contact with the inner contents of a battery. If
the eyes or mouth contact these substances, imme-
diately flush with water and seek medical assistance.

- Avoid dropping or subjecting the batteries to severe
impacts that could damage the casings.

It could lead to leakage and injury.

- Do not short-circuit the battery terminals with metallic
objects, such as key holders

It could lead to overheating, burns and other injuries.

- Before you discard a battery, cover the terminal with
tape or other insulators to prevent direct contact
with other objects

Contact with the metallic components of other materials
in waste containers may lead to fire or explosions. Dis-
card the batteries in specialized waste facilities if
available in your area.

- Use only recommended batteries and accessories

Use of batteries not expressly recommended for this
equipment may cause explosions or leaks, resulting
in fire, injury and damage to the surroundings.

- Disconnect the compact power adapter from both
the IR camera and power outlet after recharging
and when the IR camera is not in use to avoid fires
and other hazards

Continuous use over a long period of time may cause
the unit to overheat and distort, resulting in fire.

- Do not use the battery charger or compact power
adapter if the cable or plug is damaged, or if the plug
is not fully inserted into the power outlet.

The battery charger varies according to region.

- Exercise due caution when screwing on the separately

sold tele-lens, close-up lens

If you loosen, fall off and shatter, the glass shards
may cause an injury.

- If your camera is used for prolong periods, the IR
camera body may become warm

Please take care when operating the IR camera for an
extended period as your hands may experience a bur-
ning sensation.

Prevent Malfunction

Read on to learn about preventing malfunction of IR
camera.

- Avoid damaging the detector of the IR camera
- Avoid Condensation Related Problems

Moving the IR camera rapidly between hot and cold
temperatures may cause condensation (water drop-
lets) to form on its external and internal surfaces.

You can avoid this by placing the IR camera in the
plastic case (bundle) and letting it adjust to tempe-
rature changes slowly before removing it from the
case.

- If Condensation Forms Inside the IR Camera

Stop using the camera immediately if you detect con-
densation. Continued use may damage the IR camera.
Remove the PC card, and battery or a household po-
wer source, from the IR camera and wait until mois-
ture evaporates completely before resuming use.

- Extended Storage

When not using the IR camera for extended periods of
time, remove the battery from the IR camera or battery
charger and store the IR camera in a safe place. Storing
the IR camera for extended periods with battery ins-
talled will run down the battery.
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02. COMPONENT GUIDE Controls

Front View

Laser Pointer

Visual CCD Camera

llluminator

Laser trigger

Lens

\ N

\§

Focus ring

Hand strap

Back / Bottom View

Diopter Adjustment.

Viewfinder

LCD-Display

Key pad

USB-TerminaI]

Headset- |

5| RS232- Video-
/| Terminal Output

Definable button

/A

OSSN e
e s
C@}ym:cancel Key

Menu /

K Enter Key
Cursor

Auto Adjust Key

Laser Triger
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03. PREPARING THE IR CAMERA

Charging the Battery Pack

Use the following procedures to charge the battery
pack for the first time and subsequently when the low
battery icon appears on the Display Panel.

1. Align the edge of the
battery pack with the
line on the battery,
then slide the battery
in the direction of
the arrow.

2. Attach the power cord
to the battery charger
and plug the other end
into a power outlet.

e The charge indicator lights while the battery pack is
charging and goes off when charging is complete..

e After charging, unplug the battery charger and re-
move the battery pack.

e This is a lithium ion battery pack so there is no need
to complete use or discharge it before recharging. It can
be recharged at any time. However, since the maximum
number of charge cycle is approximately 300 (battery
life), you are recommended to only charge the battery
pack after having discharge it completely to prolong
battery life.

e Charging times will vary according to the surrounding
humidity and battery pack charge state.

A Battery Pack Handling Precautions

e Keep the battery pack and camera terminals clean at
all times. Dirty terminals may cause a poor contact
between the battery pack and IR camera. Polish the
terminals with a tissue or a dry cloth before charging
or using the battery pack.

e Do not cover the battery charger with anything,
such as a tablecloth, cushion or blanket, when it
is charging. Heat will build up internally and pos-
sibly lead to fire.

e Do not charge batteries other than Battery Pack F570
with supplied equipment. This may cause malfunction.

The battery pack continues to discharge a small
amount when leftin the camera even with the power
turned off. This shortens the battery life. Remove
the battery pack from the camera when it is not in
use.

Do not allow any metal objects such as key rings
totouchtheterminals,asthiscandamagethe battery
pack. To carry the battery pack, or store it during
periods of disuse, always place it in the supplied
case and store it in a cool, dry place.

Even charged battery packs continued to discharge
naturally. You are advised to charge the battery
on the day of use, or one day before, to ensure a full
charge.

Since storing a fully charge battery pack for long,
periods of time (about 1 year) can shorten its life
cycle or affect performance, you are recommended
to use the battery pack in the IR camera until the
low battery symbol displays and to store it at normal
temperature (30°C) or lower. If you do not use the
battery pack for long periods of time, charge it fully
and discharge it fully in the camera at least once a
year before returning it to storage.

The camera consumes the battery charge when the
power is on even when a function is not being
used. To conserve the battery charge, be particularly
attentive in turning the IR camera off.

Although the battery pack’s maximum operation
range is 0 to 40°C, the optimal range is 10 to 30°C.
At cold temperatures, such as those experienced
when operating in refrigerator, performance will
temporarily decline, deducting the usable time be-
fore recharging.

If the usable time of a battery pack diminished
substantially even when fully charged, it should be
replaced.
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Installing the Battery Pack / CF Card

Install Battery Pack NP-F570 (supplied) into the
camera as follows:

1. Check that the power is off and slide the battery cover
lock in the direction of the arrow.

2. Insert the battery pack.
e The battery terminal side should face upward.

e Insertthe battery pack all the way in until the battery
lock clicks. To remove the battery pack, push the
battery lock.

3. Close the battery cover.
/\ Remove the battery pack when the camera is
not in use.

You must format the internal memory in
FAT16 format. Otherwise, the IR camera may
not recognize the internal memory.

Battery Status Symbols
The following icons indicate the battery status on the
LCD display.
g () 1 Sufficient battery charge
1 Low battery
_1 Replace or recharge battery

Powering the IR camera

The power indicator remains lit while the power of the
camera is on.

1. Press and hold the power switch
for3seconds.The powerindicator
lights green.

2. After a while, a startup image will
appear on the screen.

Turning the Power Off

Hold the power switch for 3 seconds. The power indicator
goes off.

Using a Headset

The headset (supplied) can be connected to the camera
to record and replay voice comment. You can save an
image with voice comment.

B /

1. Turn off the IR camera.

2. Attach the cable of the headset
to the headset terminal (B)
the camera body.

3. Turn on the IR camera.
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Setting the Date / Time

You need to set Date / Time when the IR camera is turned
on for the first time.

1. Check that the IR camera is in null mode.

2. Press the MENU/ENTER
key then press the
<« LeftorRight » arrow
on the omni selector
to select the [Setup]
menu.

3. Press the UP A or DOWN V¥ arrow on the omni
selector to select [Date & Time] then press the
MENU/ENTER key.

4. Setting Date and time.

ePress the UP A
orDOWN v arrow on
the omni selector to
select a field to
change.

e Press the « LEFT or Msas I i
RIGHT » arrow on the omni selector to set the values.

5. After adjusting the settings, press the Menu/ Enter key
to close menu window, or press the C key to exit
without saved.

Preference Settings

In this menu item, you can display style of the built-in

menu system.

1. Check that the IR camera is in null mode.

2. Press the MENU/ENTER
key then press the
C LEFT or RIGHT »
arrow on the omni
selector to select the
[Setup] menu. e

3. Press the UP A or DOWN ¥ arrow on the omni
selector to select a field to change.

4. Other settings.
e Press the UP A or DOWN ¥ arrow on the omni

selector to select a field to change.

[Datei Analyse  Bild B

e Press the <« LEFT or
RIGHT » arrow on the
omni selector to set
the values.

5. After adjusting the set-
tings, press the Menu/ =
Enter key to close me-
nu window, or press the C key to exit without saved.

Informationen iiber lokale Einstellungen

- Date format
Sets the time display format.
DD: Represents the day.
MM: Represents the month.
YY: Represents the year.

- Data background
Sets the background style of the temperature display.
Transparent: The temperature data displays on the
screen with no background color.

Solid: The temperature data displays on the
screen in a white background box
of windows style.
- Temp unit

Sets the format of the displayed temperature unit of
the camera. , °C oder °F.
- Dist unit
Sets the format of the displayed distance unit of the
camera, Meter or Feet.
- Language
Selects the language used in the menus and messages.
- USB Mode
Sets the USB mode of the camera.
FlashDisk or Real-Time

- [lluminator
Enable or disable the integrated illuminator.

Operating manual — Infrared camera




04. BASIC FUNCTIONS thcking the Information on the LCD Monitor / Vie-
. . wfinder
Using the LCD Monitor Both the LCD monitor and the viewfinder have a filed of
If you wish to use the LCD monitor for shooting, playing vision of 100% of the actual shooting image.
back thermal images and adjusting menu settings, follow
the instruction below.

1. Openthe LCD display
in the direction of
the arrow.

2. Aim the IR camera
at the subject.

e For a better tem-
perature measure-
ment, please do
remember to make the subject in center of the
image that is shown on the LCD monitor (or the T

viewfinder). Operation | Date

The following displays in information view.

Reading

indicator  Live/ Time
e The viewfinder will shut off when opening the Freeze
LCD display. Battery status Ambient temperature
Using the Viewfinder Uber die Statusanzeige
If the surroundings Dioptrienausgleich | The operation indicartor shows the status of the

are too bright (for ex-
ample, when you are
shooting  outdoors)
and images on the
LCD monitor are not
clear, use the view-
finder for shooting.
(The same image and

camera and the available shortcut of the operation:

Status of ~ Available hotkey
the camera  in this status

l_‘_|l_‘_|
‘ |Px-of“C: Cancell g, 4

information as the LCD monitor appears in the view- Menu |Represents the menu mode.
: Represents the non-menu mode, and no
f nder)' ull analysis tools is selected.
You can adjust the viewfinder with the diopter adjust- Sp1 ...Sp9 Reptr1esents tthze current an?gl)ysis tool is
ment dial to adapt to your vision so that the display ) SPOUIOTSOL T OSho,
: : f : tatus Represents the current analysis tool is
information appears in crisp focus. of the Cap e e e
camera ) .
Represents the current analysis tool is
AT ArS areal or area2...... or areab.
Prof Represents the current analysis tool is profile
analysis.
Isot Represents the current analysis tool is
isothermnalysis.
Ny . Gance | Represents that you can press the C key to
status ' remove the current analysis tool.
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Selecting Menus and Settings

You can select the settings by pressing the
MENU/KEY key.

1. Press the MENU / —
ENTER key.

2. Press the « LEFT /
RIGHT » arrow on
the omni selector.

3. Press the UP A
or DOWN ¥
arrow on the

omni selector.
4. Press the MENU / ENTER button.

Example
1. Press the MENU / ENTER key.

2. Select a function item using <2\  <T4}
( © { ©
7~

3. Select setting contents using

File menu

Setup menu

4. Change the settings
using and Exit.

/\ Displayed menu items will vary according to
the operation and setting contents!

Resetting the Settings to Default

You can reset the menu and button operation settings

to default.

1. Turn off the IR
camera (A).

2. Press and hold the

Power switch and C
key for seconds (B).

05. SHOOTING

Focus

Aim the IR camera at
the subject. Turn the
focus ring to focus on
the target.

Image zooming

Image can be zoomed
digitally up to an ap-
proximate factor of 8
(0.1x stepping).

1. Check that the IR camera is in null mode.
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/\ The more the image is zoomed digitally, the omni selector to select
coarser its image quality will be.

. Press the RIGHT »

arrow on the omni se-
lector to zoom out, and
press the « Left arrow
to zoom in. The factor
displays aftert zoom
operation.

Quad-Display

Up to 4 images can be viewed and captured at one time.
The quad-display allows you to compare the fourimages 3. press UP A and
that are shown on the screen at the same time. DOWN ¥ arrow on the

1.

Check that the IR camera is in null mode.

. Press the « Left arrow

on the omni selector.

- Four images appear
at once (quad-display)

Thermal and visual image display

This IR camera records visual images with its built-in
digital camera. You can capture a visual image as a refe-
rence as the thermal image.

1. Press the MENU/ENTER key.
2. Press the <« LEFT or

RIGHT » arrow on the

the [Image] menu.

omni selector to select
[IR/CCD], then press
MENU / ENTER key.

- A sub menu will ap-
pear on the LCD-mo-
nitor (or in the viewfinder).

4. Press uP A

and DOWN ¥ arrow on

. Press the « LEFT / RIGHT » arrow on the omni the omni selector to se-
selector to select and activate an image. lect a display mode, i ﬁg;; f?‘i’“ﬁ m
- Only the selected image is activated. You can tET\ITER Eress MENL/
freeze / activate the selected image. &y.
- The unselected images are frozen.
. To cancel the quad-display mode, select image 1 Image only
and press RIGHT » arrow on the omni selector. In this mode, all information, including analysis tools and

temperature data will disappear.

1. Press the MENU/ENTER key.

2. Press the <« LEFT / [foee tmisee  m¥m emerert
RIGHT » arrow on the

omni selector to select
the [Image] menu.
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3.Press UP A and
DOWN Vv arrow on
the omni selector to
select [Image Only],
then press MENU/
ENTER key.

4.Press any key to
cancel the image only
mode.

e
Datei fmalyse GFEM Einstellung

Using the illuminator

The integrated illuminator can be use to illuminate the
dark areas. You can always produce clear, high-quality
visual images to do document of your inspections.

1. Press the MENU/ENTER key.

2. Press the « Left or
Right » arrow on the
omni selector to select
the [Setup] menu.

3. Press the Up A or
Down ¥ arrow on the
omni selector to select
the [Other], then press
the MENU/ENTER key.

4. Press the Up A or
Down ¥ arrow on the
omni selector to select
the [lluminator].

5. Press the < LEFT or
RIGHT » arrowonthe
omniselectortoenable
or disable the integra-
ted illuminator.

Datci Analyse  Bild

[EinstelTung]

Einstel lung-Sonstige
Datum format: JJ-HM-TT
DataHintergrund Solid

Temp Einheit: ©

Enfer. seinheit:Meter

Real-Tine
IHluninator: : Off

/\ Ifyou use the optional lens when the shoo-
ting lamp is attached, a portion of the visual
image will be blocked by the optional lens
and will appear dark.

Laser Pointer

You can activate the laser pointer
by pressing the trigger (A), and
release trigger to put it out.

Auto adjust

The IR camera will automatically adjust the brightness
and / or contrast when you select Auto adjust in the
menu or press the A key.

1. Press the MENU/ENTER
key.

2. Press the « Left or
Right » arrow on the
omni selector to se-
lect the [Image] menu.

3.Press A UP and
DOWN Vv arrow on - Hanuell ein. b

the omni selector to
select [Auto adjust], sur i
then press MENU/
ENTER key.

Datei Analyse GHCH Einstellung

Manual adjust

You can adjust the Level and Span of the image ma-
nually in the built-in menu system or by pressing ar-
rows on the omni selector. Press 4 Up and Down V¥,
arrow to change the span, and press Left and Right
arrow to change the level.

1. Press the MENU/ENTER key.

2. Press the <« Left or
Right » arrow on the
omni selector to se-
lect the [Image] menu.

Yl Einste g
a7z

Datei Analyse
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3.Press Up A and
DOWN ¥ arrow on
the omni selector to
select [Manual adj],
then press MENU/EN-
TER key.

Datei Analyse

dIf Einstellung
anuell ein. Ml

Selbst ein.

Standbild
TR/CCD »
- MNur Bild

4. Setting Level and Span

- Press the LEFT or | gpanne (,span®)
RIGHT arrow on the ,—‘—|
omni selector to se- evel -_
lect a field to change. -

- Press the UP A or | Level

DOWN ¥ arrow on
the omni selector to set the values.
5. After this operation, press the MENU/ENTER key to
save changes, or press the C key close menu window
without saving.

Measurement range
1. Press the MENU/ENTER key.
2. Press the <« Left or

Right » arrow on the

omni selector to se-
lect the [Image] menu.

Datei fnalyse RN Einstellung

3.Press UP a and
DOWN ¥ arrow on
the omni selector to
select [Manual adj],
then press MENU/EN-
TER key.

4. Setting measurement
range:

-Press the « LEFT or |"S5iec ™io.cc MRS
RIGHT » arrow on the
omni selector to se-
lect range.

-Press the UP A or
DOWN ¥ arrow on the omni selector to set the
measurement range.

- This option is unavailable when the image is frozen.

5. After this operation, press the Menu/Enter key to
close menu window.

Tenp

Bereich
(,Range®)

Freezing / Activating an image

You can activate / freeze a thermal image in the menu
system or by pressing the S key on the omni selector.
1. Press the MENU/ENTER key.

2. Press the < Left or
Right » arrow on the
omni selector to se-
lect the [Image] menu.

3. Press the Menu/Enter
key on the omni se-
lector to switch bet-
ween [Live] and [Freeze].

Datei Analyse Einstel lung

Image settings
1. Press the MENU/ENTER key.
2. Press the <« Left or
Right » arrow on the
omni selector to se-
lect the [Setup] menu.

Datei finalyse  Bild DFESZIOINT
[1:32 3]

3. Press the Up A Datei Analyse  Bild

or DOWN ¥ arrow on
the omni selector to
select [Image], then
press the MENU/EN-
TER key.
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4. Set the Image Settings.

- Press the UP A
or DOWN ¥ arrow
on the omni selec-
tor to select a field
to change.

- Press the <« LEFT or RIGHT » arrow on the omni
selector to set the values.

Einstellung-Bild

Selbst ein.:
Einst.pernanent :None
Palette
Saturierung Ci
Windousdarst. : Vor

About the Image settings:
Auto adjust
Sets the function of A key. There are three options:
Level and Span, Level, Span.
- Level und Span
The camera will automatically adjust the level
(brightness) and span (contrast) of the image to
the optimum setting.
- Level
The camera will automatically adjust the level
(brightness) of the image.
- Span
The camera will automatically adjust the span
(contrast) of the image.
Continuous adj
Sets whether or not the brightness and contrast of
the the image shown on the screen are adjusted
automatically.
- Level and Span
The brightness and contrast is adjusted automatically.
- Level
The brightness is adjusted automatically.
- None
The brightness and contrast will not be adjusted
automatically.
Color scale
Sets the pseudo color of the thermal. The camera pro-
vides 6 palettes: Iron, Iron inverted, Rainbow, Feather,
Grey and Grey inverted.

Saturation color

Sets the display of the part that is beyond the tempera-
ture range of the color scale.

-0On

Sets the saturation color of the image in green or black.
- Off

Sets no saturation color of the image.
Windows style
Sets the style of built-in menu system.
- Standard

Sets the built-in menu system in standard style.
- Skyblue

Sets the built-in menu system in vogue style.
Setting object parameter
1. Press the MENU/ENTER key.

2. Press the « Left or
Right » arrow on the
omni selectorto select
the [Analysis] menu.

Datei JMIUEE Bild Einstellung

o |

Eﬁ

3. Press UP A and DOWN
¥ arrow on the omni se-
lector to select [Obj par],
then press the MENU/EN-
TER key.

4. Setting object parameter.

- Press the UP A or
DOWNVarrowonthe
omni selector to se-

lect a field to change.

- Pressthe « LEFT or i‘ mg Temp
RIGHT » arrow on iLuMeu

Operating manual — Infrared camera




5. After this operation, press the MENU/ENTER key to
save changes, or press the C key close menu win-
dow without saving.

About the Object parameter

Object Para

- Object
Select an analysis tool to change its parameter.
You can select spot1-10, areal-5, profile and iso-
therm. You can set different parameters to different
analysis tools.

- Emiss
Different object has different emissivity. Use different
emissivity to measure different object.

- Distance
DifferentobjecthasdifferentdistancetothelRcamera.
Use different distance to measure different object.

Global Para

- Amb Temp
Input ambient temperature.

- Humidity
Input ambient humidity.

- Comp 0Obj
Compare the temperature of comp obj1 and comp
obj2. Obj1 and obj 2 can be selected as spot(1-9),
cap(spot10), area(1-5), profile and isotherm. The

temperature difference will display on the right-
bottom on the screen.

- Ref Temp
This is for comparison. When input this value, the
camera can adjust the temperature reference value.

Setting analysis parameter

Dieser Themenbereich erklart, wie die Analyse-Tools
auf dem Thermalbild eingestellt werden.

1. Press the MENU/EN- (e
TER key.

2. Press the « Left or
Right » arrow on the
omni selector to select
the [Setup] menu.

[Einstellung]
[1:32.5]

3. Press UP A or DOWN ¥ arrow on the omni selector
to select a field to change.
4. Setting analysis parameter.
- Press the UP or DOWN arrow on the omni selector
to select a field to change.
- Pressthe « Left or Right » arrow on the omni
selector to set the values.

5. After this operation, press the MENU/ENTER key to
save changes, or press the C key close menu window
without saving.

About the analysis parameter
Capture Spot
Sets spot10 to automatically track the highest / lo-
west spot on the screen.
- Max
Set the spot10 to
track the hottest spot
on the screen.
- Min
Set the spot10 to

track the coolest spot
on the screen.

Area function

Datei fnalyse  Bild

[Einstellung]

SetS the reading '[ype Of Einstellung-fAnalyse

H _ |Spot finden : Maximum
apalysw_ area. The 162" | poroich HiEeElFerTd
ding will be shown in |Profile:

. Isoth t : Ind 1 |
the right bottom of the |iSgenermbreite: = 5.0¢
screen. When more than | Isothernfarbe : Gruen

. Alarm: aus

one area is setted, the [alarm temp: 100C
reading will be shown [feffexenztemp: ° o€
alternately.
- Max

The highest temperature within the area will be
shown.

- Min
The lowest temperature within the area will be
shown.

- Average
The average temperature within the area will be shown.
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Profile

- Horizontal
The profile analysis will be horizontal.

- Vertical
The profile analysis will be vertical.

Isotherm type

Sets the isothermal analysis mode. There are five
modes: Dual Above, Dual Below, Above, Below and
Interval.

- Dual Above
Display the isothermal interval in a color and the
parts with the higher temperatures than the upper ,
limit of the isothermal interval in a different color

- Dual Below
Display the isothermal interval in a color and the
parts with the lower temperatures than the lower
limit of the isothermal interval in a different color

- Above
Display the isothermal interval and the parts with
the lower temperature than the upper limit of the
isothermal interval in the same color.

- Below
Display the isothermal interval and the parts with
the lower temperature than the lower limit of the
isothermal interval in the same color

- Interval
Display the isothermal interval in one color and all
the other parts are displayed in the normal pseudo
color mode
Isotherm width
Sets the width of isothermal interval. The width can
be adjusted from 0.1 °C to the upper limit of the ma-
ximum temperature measurement range under this
condition.
Isotherm color

Sets the color of the isotherm interval. Transparent,
Green, Black and White are available.

Alert

Enable or disable the temperature alert. When the set-
ting is “On”, the temperature reading of “Spot 10” will

be displayed in red, meaning the alert status, if the set-
ting [Spot] / [Setup-analysis] is “Maximum”, and the
measured temperature in “Spot 1”7 of “Manual adj” is
higher than the preset alert temperature. On the con-
trary, if “Spot 1”, set as “Minimum” in [Spot] / [Setup-
analysis], has a temperature lower than the preset alert
temperature, the temperature reading will be displayed
in the alert mode.

Alert temp
Sets the temperature limit of “Alert”.
Correct temp

Corrects the measured temperature value of the came-
ra to ensure the measurement accuracy under special
circumstances.

Spot analysis

1. Press the MENU/EN-
TER key.

2. Press the « Left or
Right » arrow on the
omni selector to select
the [Analysis] menu.

3. Press Up A and DOWN
¥ arrow on the omni
selector to select [Spot],
then press the Menu/
Enter key.

4. Setting the spot ana-
lysis.

Press the UP A or
DOWN ¥ arrow on
the omni selector to
select a spot, then
press MENU/ENTER
Key. One or more
crosshairwillappear
on the screen.

- Spot 10 will automatically track the highest or
lowest spot on the screen.

Datei JMIMEE Bild Einstellung

oz 1 |

Bereich P
Profile
Isothern
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5. Moving the analysis
spot:

- Start from Step 1
to set or select a
spot analysis.

- Currentanalysisspot
will appear in the
operation indicator.

- Press the UP A, DOWN ¥, « LEFT und RIGHT »
arrow on the omni selector to move the activated spot.

- Temperature value of current spot will magnify.

- You can measure the highest/ lowest temperature
of the image.

Area analysis

5. Moving the analysis area

- Start from Step 1 to

set or select an Area
analysis.

- A Current analysis
areawillappearinthe
operation indicator. n -

- Den aktuellen Bereich konnen Sie m|t Pfell nach
OBEN A, UNTEN ¥, « LINKS und RECHTS » auf
dem Tastenfeld verschieben.

- Mit bestimmten Tastenkombinationen ldsst sich
auch die Form des aktuellen Bereichs andern.

- Press the UP a or DOWN v, « LEFT, Right » arrow
on the omni selector to move the current spot.

1. Press the MENU/ENTER key.

2. Press the <« Left or
Right » arrow on the
omni selectorto select
the [Analysis] menu.

3. Press UP A and DOWN
v arrow on the omni
selector to select [Area],
then press the Menu/
Enter key.

4. Setting the analysis
area.

- Press the UP A or
DOWN ¥ arrow on
the omni selector to
select an Area, then
press MENU/ENTER
key. One or more
box will appear on
the screen.

Areading will appear
at the bottom right
corner. It is the
reading of the high-
est/lowest/average

temperature of the i

current area.

Datei JEINEE  Bild Einstellung

Profile analysis

1. Press the MENU/ENTER key.

2. Press the « Left or
Right » arrow on the
omni selector to select
the [Analysis] menu.

3.Press UP A and

DOWN v arrow on the

omni selector to select

[Profile], then press the

Menu/Enter key. A profile

will appear on the screen.

4. Moving the profile
analysis.

-Start from Step 1 to
set or select a profile
analysis.

- Press the UP A or
DOWN V¥ arrow (for
horizontal profile) /
« LEFT/RIGHT » (for
vertical profile) arrow
on the omni selector
to move the profile.

Datei JMNUEE Bild Einstellung

[z |

)

Datei TENUEY Bild Bmst.ellnng

Obj.Par. >
Spot.

i )

lsotllern

Alles abl. |l
—ti-

Temperature distribution
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5. Moving the crosshair on
the profile:

- Start from Step 1 to
set or select a profile
analysis.

- Press the <« LEFT,
RIGHT » arrow  (for

[sP_c|49. 1
1:41.5

Crosshair

Temperature of the crosshair

horizontal profile) / UP a, DOWN V¥ (for vertical pro-
file) arrow on the omni selector to move the crosshair

on the profile.

Isotherm analysis

1. Press the MENU/EN-
TER key.

2. Press the « LEFT or
RIGHT » arrowonthe
omni selector to select
the [Analysis] menu.

3. Press UP A and DOWN
v arrow to select [Iso-
therm], then press the
Menu/Enter key. Areas
of concern will be high-
lighted with color.

4. Setting isotherm range:
- Start from Step 1 to

set or select iso-
therm analysis.

- [Isot] message will
appearinthe opera-
tion indicator.

- Press the UP A or
DOWN ¥ arrow on
the omni selector to
select isotherm range.

- ILandIHwillap-pear

Datei JEYMES Bild Einstellung

IL28.9
IH25.9 1

82 8848

at the bottom right corner. It is the high limit (IH)
and low limit (IL) of the isotherm range.

Remove analysis tools individually
1. Press the MENU/ENTER key.

2. Press the <« LEFT or
RIGHT »
omni selector to select the
[Analysis] menu.

- Current analysis tool
will appear in the
operation indicator .

- You can skip this step and step 3 when the analysis
tool you want to remove is the current analysis tool.

3. Select the analysis tool you want to remove.
4. Press the C key to remove it.

Datei JMIORE Bild Einstellung

iiaz.1

arrow on the u|

Remove all analysis tools

1. Press the MENU/EN-
TER key.

2. Press the <« LEFT or
RIGHT » arrowonthe
omni selectorto select
the [Analysis] menu.

Datei JEIOEE  Bild Einstellung

Datei TXNWEY Bild Einstellung

0bj.Par. b

3. Press UP A and DOWN

¥ arrow to select [Re- gt b
move all], then press peetile
the Menu/Enter key. Al
analysis tools removed.

Saving the Image

You can save the image in the menu system after you
freeze an image, or save it directly by holding the S key
on the omni selector for 3 seconds when the camera is
in Null mode without freezing an image.

1. Press the MENU/EN-
TER key.

2. Press the < LEFT or
Right » arrow on the
omniselectorto select
the [File] menu.

IR Analyse  Bild  Einstellung
[1:92.2]
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3. Press the UP A and
DOWN ¥ arrow on the
omniselectorto select
[Save], then press the
Menu/Enter key to save
the image.

DTN Analyse  Bild Einstellung

i fen
ISpeichern
N

Save Settings
1. Press the MENU/EN-
TER key.

2. Press the Left or Right
arrow on the omni
selector to select the
[Setup] menu.

3. Press UP and DOWN
arrow on the omni
selector to select
[File], then press
the Menu/Enter key.

Datei Analyse Bild GIESZIIO
[1:92 3]

4. Changing save settings:

- Press the UP A or
DOWN Vv arrow on
the omni selector to

Einstellung—Datei

Datei tup

Speichern typ: Nummer

NumMerZeit : 2r

select a field to
change.

- Pressthe « LEFTorRIGHT » arrow on the omni
selector to change the settings

About save settings:

File Type

Sets the recording type of the image.

- Both: Saves thermal image and visual image.

- IR: Saves thermal image only.

- CCD: Saves visual image only

Storage Type

You can select the way file numbers are assigned.

- Number: This function allows you to save more
than one images at one time.

- Time: This function can be used for fix-point obser-
vation of object.

Number / Time

This option varies to the storage type setting. When
you set the storage type to [Number], [Number] in this
option is available. When you set the storage type to
[Time], [Time] in this option is available.

- Number: Sets the number of images saved at one time.
- Time: Sets the shooting interval time.

Attaching Voice Memos to Images

You can attach up to 40 second voice memo to an image.
1. Connect the headset to the camera body.

2. Freeze an image, the Press the MENU/ENTER key.
3. Press the <« LEFT or (N

RIGHT » arrowonthe »

omni selector to se-

lect the [File] menu.
4. Press UP A and DOWN

V¥ arrow on the omni [ . )|

selector to select [Voice

REC], then press the

Menu/Enter key.

- The [Voice Recording]
messagewillappear
on the LCD monitor
or viewfinder.

5. Speak toward the microphone of the headset. To
stop recording, press the C key.

6. Save the image.

/\ The storage capacity of the memory will not
decrease when you attach voice comment
to an image.

Attaching Text Memos to Images
1. Freeze an image, then Press the MENU/ENTER key.
2. Press the <« LEFT or [EEEs i mmmins

RIGHT » arrow on the
omni selector to se-
lect the [File] menu.
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3. Press UP A and DOWN
¥ arrow on the omni
selector to select [Com-
ment], then press the
Menu/Enter key.

=
IXTH Analyse  Bild Einstellung

- The [Comment] window
will appear on the
LCD monitor (or in the
viewfinder).

4. Select a comment by
pressing the UP A or
DOWN ¥ arrow on the
omni selector, and then 2 e e
press the Menu/Enter key to attach a text comment.

5. Save the image.

06. PLAYBACK AND ERASE

How to select an image

1. After you select [Open] or [Delete] option under
[File] menu, a message shown as below will ap-
pear in the lower left of the screen.

69141330.SAT 001
2006-10-12 010

File name of the ~ The date on Number of Sequence
current image which the Images in this number of the
current image folder current image
was saved

2. If the image you wish to open or delete is not in
the current folder, press the UP A arrow on the
.. <DIR>

Enter or Cancel

IEZS Analyse  Bild Einstellung

Opening Images

You can view and analyze
the recorded images on
the LCD monitor (or in the
viewfinder).

1. Press the MENU/EN-

omni selector until the following message appear:

3. Press [Menu/Enter] key to select a dirtory or
ress [Cancel] key to exit. After you press

20061012 <DIR>

TER key.

2. Press the <« LEFT or
RIGHT » arrow on the
omni selector to select
the [File] menu.

3. Press UP A and DOWN
¥ arrow on the omni
selector to select [Open],
then press the Menu/
Enter key.

4. Select an image, then
pressMENU/ENTER key
to open it. You can ana-
lyze and attach memo
to a recorded image
when you open it.

20041812 <{DIR>» ‘
BaB 882 /882

001 / 002 / 003——L
enu/Enter keﬂtoselectadlrectory ameksage

bs#l Sequence Numbers of
the C rpgﬁm er Image3| i numbers of the folder in the CF
folder Card

current folder.

4. Press UP A or DOWN V¥ ] arrow on the omni selector
to select a folder, then repeat step 1 to select an image
in the selected folder.
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69155526 69155527 69155540 69155541

69155634 69155671 69155672

Wurzel- 2006101

verzeichnis V—

des internen I:I
Speichers =

20061012 69155633
i [ ]
69156667

- [ ]

69156667
120061021,

69156668

69156668

[ L]

69156687 69156689

[ IL ]

69156694 69156695

Das ist das Datum,
an dem der Ordner
erstellt wurde

A About File and Folder Numbers

The folders are named by the date on which is
created. The images are named by the sequence
number.

The camera checks folders in the CF card eve-

ry time you power on the camera. It creates a

folder named by the date of the system clock
if such folder doesn’t exist. It is the default folder
and all images will be saved in this folder. The de-
fault folder changes to
the last folder you se-
lected and all images
will be saved in it.

IS Analyse  Bild Einstellung |

\

FXTH Analyse  Bild Einstellung
iffnen b

Speichern

Lischen )

Auf zeichnung

Playback Memos

1. Attach the headset to
the camera body.

2. Open an image.

3. Press MENU/ENTER key
thenpress ¢ LEFTor
RIGHT » arrow on the
omni selector to select

Kommentar. .»

the [File] menu.

4. Press UP A and DOWN
v arrow on the omni
selector to select [Voice
Play], then press the
Menu/Enter key.

T — TN TR T J!Ll.x

-A [Playing Record]

message will appear
on the LCD monitor

/\ (orin the viewfinder).
5. You can terminate the

playback of voice com-
ment by pressing C
[ nalyse _bila_Einstellng |
key. =

Erasing Images

Please note that
erased image cannot
be recovered. Exercise
caution before erase
an image.

1. PressMENU/ENTERkey
then press « LEFTor
RIGHT » arrow on the
omni selector to se- &= ‘ e
lect the [File] menu.

2. Press UP A and DOWN
v arrow on the omni

selector to select [De-
lete], then press the
Menu/Enter key.

3. Select an image, then E= -
press MENU/ENTER key
to delete the selected
image.

4. Press the C key to exit.
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07. CONNECTION AND
DOWNLOAD
Connecting to a Monitor

A video-compatible monitor connected via the video
cable (supplied) can be used to view and analyze images
you shoot.

1. Turn off the IR camera.

2. Attach video cable to the
video out terminal on the
IR camera.
USB-PORT

USB-KABEL
3. Plug the other end of the
video cable to the video in
jack on the monitor.

4. Turn on the monitor and the IR camera.

Connecting to a
Gomputer

Connect the USB
cable (supplied) to
the computer’s USB

port and the camera’s terminal. You do not need to
turn off the computer or camera when making this
connection. Please refer to your computer manual for
information regarding the location of the USB port.
Download Directly via USB

You can download images taken with the IR camera to
a computer directly via the USB.

1. Enter the menu,
then select Setup
Other.
2. Select USB Mode,
then sets it to
FlashDisk.

/\ 3. Connect the IR camera to your computer. Via
USB.

4. The operation system will
recognize the camera as
a mass Storage 3') Found New Hardware
. EZ-USE FX2
device. The came-

ra will install to you
computer without any
additional driver.

5. After the installa-
tion  completed, lo-
cate  the directory

of the camera.

Reboot is necessary if
you set the USB Mode |
from FlashDisk to Re-
al-Time.

Installing the driver
(Real-time transfer)

Attach the supplied USB
cable (supplied) to the
computer’'s USB port
and the camera’s USB
terminal. Set the real-
time disk (supplied) to
the CD-ROM driver.

Users of Windows XP
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Professional / Win- [
dows 2000 must first
log in as an Adminis-
trator to install pro-
grams.

1\ The oot o v saling o s s
GZ5AT IR sens Cameta 5160

s o s Windouss Logs esting t verly s competislly
with Wirclows <P (Tell me why rés esting s mpoart

09. GARE AND MAINTENANCE
Camera Body

Wipe the body clean with soft cloth or eyeglass lens
wiper.

Lens

First use a lens blower brush to remove dust and dirt,
then remove any remaining dirt by wiping the lens lightly

you
contact the hardwaro
passed

‘Windows Loga testing.

1. After a few moments,
the following dialog
will appear.

2. Select [No, notthistime]

then click [Next >]. with soft cloth.
LCD monitor
Use a lens blower brush to remove dust and dirt. If ne-
cessary, gently wipe the viewfinder and LCD monitor
with soft cloth or an eyeglass lens wiper to remove stub-
3. Select [Install from a borndirt.
list or location] then  Never use thinners, benzene, synthetic cleaners or
click [Next >]. water to clean the camera. These substances may
distort or damage the equipment.
4. Select [Include this loca-
tion in the search:] then
click. Locate the direc-
tory of the driver, and
click [OK] to return to
the previous window.
N\ Then click [Next >].
5. Click [Continue Any-
way].
6. Click [Finish] to finish

the driver installation.
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10. TROUBLES SHOOTING

Problem

Cause

Solution

Power is not turned on

Turn on the camera

Camera will not operate

Insufficient battery voltage

Fully charge the battery

Poor contact between camera and
battery terminals

Wipe the terminals with a clean,
dry cloth

Camera will not record

Internal memory is full

If required, download the images
to a computer and erase them
to make some space

Internal memory not
formatted correctly

Format the internal memory in
FAT16 format

Battery pack consumed quickly

Battery pack capacity reduced

because of disuse for one year or | Replace the battery pack
more after being fully charged
Battery life exceeded Replace the battery pack

Battery pack will not charge

Poor contact between battery pack
and battery charger

e Clean the battery terminals
with clean cloth.

e Connect the power cord to the
battery charger and insert its
plug firmly into the power outlet.

Battery life exceeded Replace the battery pack
11. EMISSIVITY TABLE
Material Temperature | Emissivity Material Temperature | Emissivity
(°C) approximation (°C) approximation
Aluminum Copper
Polished aluminum | 100 0,09 Copper mirror 100 0,05
Commgrcial alumi- 100 0,09 Strong copper oxide | 25 0,078
num foil Liquid copper 1080 ~1280 | 0,16 ~ 0,13
i o Brass
E:Zgrg:xt:i::rome 25~600 1055 Brass mirror 28 0,03
Mild alumina 25~600 |0,0~0,20 | |Brassoxide 200 ~ 600 | 0,61 ~0,59
Chrome
stongalumina | 25 ~600 0,30 ~040 | | pyjigneq chrome | 40~ 1090 | 0,08 -~ 0,36
Copper Gold
Cuprousoxide | 800~ 1100 | 0,16 ~0,13 | | Gold mirror | 230-~630 | 0,02
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11. EMISSIVITY TABLE

Material Temperature | Emissivity Material Temperature | Emissivity
(°C) approximation (°C) approximation
Iron Nickel
Polished cast iron 200 0,21 Nickel-chrome
(heatresistance) 50 ~1000 | 0,65~0,79
Processed cast iron | 20 0,44
Nickel-chrome alloy | 50 ~ 1040 | 0,64 ~ 0,76
Polished tempered
iron 40 ~ 250 0,28 Nickel-chrome (heat
resistance) alloy 50~500 | 0,95~0,98
Polished steel ingot | 770 ~ 1040 | 0,52 ~ 0,56
Nickel-silver alloy 100 0,14
Raw welded steel 945 ~ 1100 | 0,52 ~ 0,61
Lead
L Pure lead
Surface ferric oxide | 20 0,69 (Non-oxidization) 125 ~ 225 0,06 ~ 0,08
Completely rusty Stainless steel
vy “ o 18-8 25 0,16
Rolled iron plate 100 0,74 - ’
Oxidized steel 198 ~ 600 | 0,64 ~ 0,78 SUat ) AL U 2l
Cast iron 310 (25Cr, 20Ni) 215~520 | 0,90 ~ 0,97
i o 198 ~ 600 | 0,79 .
(Oxidizing at 600°C) Tin
Steel Commercial tin plate| 100 0,07
(Oxidizing at 600°c) | 122~ 920 | 0,78 ~0,82 ——
Electrolytic ferr Strong oxidization | 0 ~200 0,60
ectrolytic ferric .
oxide 500 ~ 1200 | 0,85 ~ 0,89 Zinc
Iron plate 925 ~ 1120 | 0,87 ~ 0,95 Oxidizing at 400°C | 400 0,01
Cast iron, heavy ferric galvanized shining
oxide W 25 0,80 iron plate 28 023
Tempered iron, ferric Ash zinc oxide 25 0,28
. ’ 40 ~ 250 0,95
oxide Magnesium
Melting surface 22 0,94 Magnesia 275~825 | 0,55~0,20
Melting cast iron 1300 ~ 1400 | 0,29 Hg 0~100 0,09~0,12
. . Nickel
Melting mild steel | 1600 ~ 1800 | 0,28
Liquid steel 1500 ~ 1650| 0,42 ~ 0,53 | | Electroplate polishing | 25 0,05
Pure liquid iron 1515~1680| 0,42 ~ 0,45 Electroplate 20 0,01
Silver Nickel wire 185~1010 | 0,09 ~0,19
Polished silver ‘ 100 0,05 Nickel plate (oxidized)| 198 ~600 | 0,37 ~0,48
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11. EMISSIVITY TABLE

Material

Nichtmetallische Mat
Brick
Fire brick

Graphite
(lamp black)

Porcelain enamel
(white)
Asphaltum

Glass (surface)
Heat-resistance glass
Calcimine

Carbon piece
Isolation piece
Sheet metal

Glass pipe

Loop type

Porcelain enamel
products

Porcelain enamel
designs

Solid materials
Ceramics (vase type)
Film

Temperature
(°C)

erialien
1100

1100
96 ~ 225

18

0~200
23
20
20

Heat-resistance glass

200 ~ 540

Emissivity
approximation

0,75
0,75

0,95

0,90

0,85
0,94
0,90
0,90
0,85
0,91 ~ 0,94
0,88 ~ 0,90
0,90
0,87

0,90

0,83 ~ 0,95

0,80 ~ 0,93
0,90

0,90 ~ 0,93
0,85 ~ 0,95

Material

Nichtmetallische Mat
Mica

Flume mica
Glass
Semiconductor

Transistor
(plastics sealed)

Transistor Diode
(metal)

Diode
Level chalkiness
Top loop

Elektrische Materialien

Epoxy glass plate
Epoxy hydroxyben-
zene plate

Gilded sheet copper

Solder-coated
copper

Tin-coated lead wire

Brass wires

Block talcum
terminal

Temperature
(°C)
erialien

Emissivity
approximation

0,94 ~ 0,95
0,90 ~ 0,93
0,91 ~ 0,92
0,80 ~0,90

0,30 ~ 0,40

0,89 ~0,90
0,91 ~0,92
0,88 ~0,93
0,91 ~0,92
0,86
0,80
0,30
0,35
0,28
0,87 ~0,88
0,87
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12. SPECIFICATION

Thermal

Field of view 24°x18°/0,3 m (with 35-mm-Lens)

Spatial resolution (IFOV) 1,3 mrad

Thermal sensitivity 80 mK at 30 °C

Image frequency 50/60 Hz non-interlaced

Focus manual

Electronic zoom 1x-8x (0.1x stepping)

Detector type Focal Plane Array (FPA), uncooled microbolometer 320x240 pixels
Spectral range 7,5t013 pm

Visual

Built-in digital video
Image Presentation

640x480 pixels, full color

Video output PAL or NTSC (optional) composite video
Viewfinder Built-in, high resolution color LCD (TFT)
External display 3.5” LCD with integrated remote control
Measurement

Temperature range

Range1 -20°C to +180°C, (-4°F to +356°F)
Range2 +160°C to 600°C, (+320 to 1112)

Accuracy +2°C, +2% of reading
(up to 10 movable), manual or automatic
placement and
Spot ; .
reading of max. min. average
temperature within area
Measurement mode
Area (up to movable 5 boxes)
Isotherm Reporting software
Linen profile Typll
Emissivity correction Variable from 0.01 to 1.00 (0.01 stepping)
Ambient temperature correction automatic
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12. SPECIFICATION

Image Storage
Type

Internal flash memory (128MB)

File formats — Thermal

SAT format, 14 bit measurement data included

File formats — Visual

CCD format

Voice annotation of images

40 sec. digital voice “clip” stored with corresponding thermal images

Text annotation of images

Predefined text selected and stored together with the image

Laser pointer

classification Class 2

Type Semiconductor AlGalnP Diode Laser, 1Tmw/635 nm red
Battery System

Type Li-on, rechargeable, field replaceable

Operating time

2.5 hours continuous operation

Charging system
Environmental Specification
Operating temperature range

External 1 bay intelligent charger

-15°C to +50°C (5°F to +122°F)

Storage temperature range

-40°C to +70°C (-40°F to +122°F)

Humidity

Operating and storage 10% to 95%, non-condensing

Encapsulation IP 54
Shock Operational: 259
Vibration Operational: 29

Physical Characteristics
Weight

1,08 kg

Size (HxW x D)

184.4mm x 89.1mm x 162.9mm (7.3"x3.5”’x6.4”") camera body

Tripod mounting

1/4” - 20

Interface

USB 2.0 Download images and real-time thermal video

Video out Composite video

RS-232 Remote control with computer
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